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ii Dimatix Materials Printer
1.0 About this Manual

Throughout this manual a variety of conventions are used to highlight essential 
information that is important for the overall safety and understanding of issues in using 
this product. These include:

1.1 Warnings

1.2 Cautions

1.3 ESD Advisory ESD = Electrostatic Sensitive Device    (EGB = elektrostatisch 
gefährdetes Bauteil)

!
WARNING This symbol identifies information about 

procedures, practices or conditions that can result 
in damage to the product, economic loss, personal 
injury, or death.

(Dieses Symbol kennzeichnet Hinweise zu 
Handlungsweisen, Methoden oder Zuständen die 
zu Schäden am Produkt, wirtschftlichem Verlußt, 
Personenschäden oder zum Tode führen können.)

CAUTION

!
This symbol identifies information about practices 
or circumstances that may lead to damage to the 
product or other economic loss.

(Dieses Symbol kennzeichnet Hinweise zu 
Handlungsweisen oder Umstände die zu Schäden 
am Produkt oder anderen wirtschaftlichen Schäden 
führen können.)

This symbol identifies where there may be risk of 
damage to the product due to Electrostatic 
Discharge.

(Dieses Symbol kennzeichnet Punkte an denen das 
Produkt durch elektrostatische Entladung 
beschädigt werden könnte.)
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Dimatix Materials Printer iii
1.4 Wheelie Bin Symbol

1.5 Important

1.6 Notes

 Note: Used for emphasizing additional information that aids in the understanding 
and use of the product.

This symbol identifies parts that should be 
reclaimed as part of the Waste Electrical and 
Electronic Equipment (WEEE) Directive.

IMPORTANTIMPORTANT This symbol identifies information that is essential 
to the understanding and correct use of this product.

(Dieses Symbol kennzeichnet, für das Verständnis 
und den richtigen Umgang mit dem Gerät, 
wesentliche Hinweise.)
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2.0 Important Safety Information (Wichtige Sicherheitshinweise)

2.1 Safety (Sicherheit)

!
WARNING Only qualified, service-trained personnel who are aware 

of the hazards involved should perform calibration, 
maintenance, or repair of the product. Only these 
qualified personnel should remove the covers from the 
product.

(Kalibrierungen, Wartungen oder Reparaturen am 
Produkt sollten nur von qualifiziertem Servicepersonal, 
das sich den bestehenden Gefahren bewusst ist, 
vorgenommen werden. Nur qualifiziertes Servicepersonal 
sollte die Abdeckungen am Produkt entfernen.)

!
WARNING For continued protection against fire, replace the line 

fuses only with fuses of the specified type and rating.

(Ersetzen Sie die Eingangssicherung nur mit Sicherungen 
des spezifizierten Typs und der spezifizierten Leistung, 
um einen sicheren Betrieb zu gewährleisten und Bränden 
vorzubeugen.)

!
WARNING Modification or misuse of the product or components can 

cause harm to the user and will void any warranty.

(Veränderungen oder Missbrauch des Produkts, oder 
Veränderungen oder Missbrauch von Komponenten 
können den Benutzer oder Dritte schädigen und führen 
zum Garantieverlußt.)
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!
WARNING The product must be connected to a protective earth 

conductor via the three-wire power cable. The power plug 
shall be inserted only into a grounded outlet. Do not 
defeat the protective action by using an extension cord 
without a grounded conductor.

(Das Produkt muß durch den Betrieb mit einem 
dreiadrigen Stromkabel geerdet werden. Der Stecker darf 
nur in eine geerdete Steckdose gesteckt werden. 
Benutzten sie nur dreiadrige Verlängerungskabel mit 
Erdung.)

!
WARNING For Dimatix Materials Printer (DMP-2800) serial 

numbers less than 2831-0646-XXXX-XXXXXXXXX: 
Fluid used in this product must have a fire point greater 
than 125 °C.

(Beachten sie bei Dimatix Material Druckern (DMP-
2800) mit einer Seriennummer kleiner als 2831-0646-
XXXX-XXXXXXXXX: Fluide die in diesem Produkt 
benutzt werden müssen einen Flammpunkt grösser als 
125 °C aufweisen.)

!
WARNING Do not overfill the ink cartridge. Its maximum capacity is 

1.5 milliliters.

(Überfüllen sie die Druckerpatrone nicht. Das maximale 
Fassungsvermögen der Druckerpatrone beträgt 1,5 
Milliliter.)
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!
WARNING Do not operate the product in an explosive atmosphere. 

Do not operate the product in the presence of 
inflammable gases or fumes. Operation of any electrical 
instrument in such an environment clearly constitutes a 
safety hazard.

(Benutzten sie das Gerät nicht in explosiver Atmosphäre. 
Benutzen sie das Gerät nicht in der Nähe von 
entflammbaren Gasen oder Dämpfen. Der Einsatz 
jeglicher elektronischer Geräte in einer solchen 
Umgebung stellt eine eindeutige Sicherheitsgefährdung 
dar.)

!
WARNING Care must be used when jetting multiple fluids. It may be 

possible for reactions to occur in the absorbent pads 
where multiple and or incompatible fluids may come in 
contact with each other.

(Vorsicht ist beim Umgang und Druck mehrerer 
verschiedener Flüssigkeiten geboten. Es ist möglich, dass 
Reaktionen in den Absorberkissen stattfinden, wenn 
inkompatible Flüssigkeiten miteinander in Kontakt 
geraten können.)

!
WARNING The platen can reach temperatures of 60 °C, which is hot 

to the touch. It can melt some materials if placed on it 
while hot, and it can cause volatile materials to evaporate 
faster if placed on the platen when hot.

(Die Substratplatte kann Temperaturen von bis zu 60 °C 
erreichen. Dies ist zu heiss, um sie gefahrlos zu berühren. 
Diese Temperatur kann Materialien zum schmelzen 
bringen, wenn diese auf die Platte gestellt werden. 
Ausserdem verdampfen flüchtige Materialien schneller 
wenn sie auf die heisse Platte gestellt werden.)
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2.2 Important (Wichtig)

!
WARNING The cartridge can reach temperatures of 70 °C, which is 

hot to the touch, and it can cause volatile materials to boil 
off faster. Care must be taken that the cartridge settings 
are appropriate when installing a cartridge with volatile 
fluids.

(Das Cartridge kann Temperaturen von bis zu 70 °C 
erreichen. Dies ist zu heiss, um es zu berühren. 
Ausserdem verdampfen flüchtige Materialien schneller 
wenn sie das heisse Cartridge berühren. Die Cartridge 
Einstellungen müssen sehr sorgfältig gewählt werden, 
wenn mit leicht flüchtigen Materialien im Cartridge 
gearbeitet wird.)

IMPORTANTIMPORTANT All moving parts are interlocked to the printer lid. The 
machine will stop if the lid is lifted during operation.

(Alle beweglichen Teile sind mit der Drucker-Klappe 
gekoppelt. Die Maschine bleibt stehen wenn die Klappe 
im Betrieb geöffnet wird.)

IMPORTANTIMPORTANT Replaceable pads capture and hold virtually all ink jetted 
into them. In many cases this may then be considered 
“solid waste” rather than “liquid waste.” Please dispose of 
properly.

(Die austauschbaren Absorberkissen können fast alle 
Tinten aufnehmen. In vielen Fällen gilt dies ehr als 
„Fester Abfall“ und nicht als „Flüssiger Abfall“, bitte 
entsorgen sie diesen fachgerecht.)
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 Note: This equipment has been tested and complies with the limits for a Class 
A digital device, pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in 
which case the user will be required to correct the interference at one’s 
own expense.

 Note: This product complies with the radio interference requirements of the 
European Union.

IMPORTANTIMPORTANT This product complies with INSTALLATION 
CATEGORY II and POLLUTION DEGREE 2 in 
IEC61010-1. This product is an INDOOR USE product.

(Dieses Produkt erfüllt die Forderungen der „Installation 
Category II“ und „Pollution Degree 2“ nach IEC61010-1. 
Dieses Produkt ist ein Produkt für den Gebrauch in 
trockenen Räumen.)

IMPORTANTIMPORTANT The LEDs within this product are Class 1 in accordance 
with IEC60825-1, CLASS 1 LED PRODUCT.

(Die LEDs in diesem Produkt entsprechen Class 1 nach 
IEC60825-1, Class 1 LED Product.)

Do not dispose this product as unsorted municipal 
waste. Collection of such waste separately for 
special treatment is necessary.

(Entsorgen sie dieses Produkt nicht als 
unsortierten Hausmüll. Eine fachgerechte 
Entsorgung ist nötig.)
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Chapter 1

Introduction

The Dimatix Materials Printer (DMP) is a laboratory and limited production tool that 
enables researchers, scientists, and engineers to evaluate the use of ink jetting technology 
for new manufacturing and analytical processes. It is designed to be convenient and easy 
to use to carry out “proof of concept” and development work using ink jet technology. It 
does have extensive capabilities to allow increased experimental sophistication to 
optimize process parameters for the user’s applications as the user gains familiarity with 
the system.

 Sheet substrate scanning ink jet deposition system with drop observation, spot 
location, and variable printing resolution

 User-fillable piezo-based jetting cartridges:

 Fluid module with syringe filling system
 16 nozzles at 254 µm spacing

 PC-controlled operation, including visual monitoring of ink jetting and printed 
pattern inspection
FUJIFILM Dimatix, Inc. Confidential Information Doc. # PM000040 Rev. 05
 December 8, 2010



2 Chapter 1 - Introduction
1.0 System Accessories
 Personal Computer (supplied)

 2.8 GHz CPU minimum
 One USB 2.0 ports on computer (shows up as “Standard Enhanced PCI to USB 

Host Controller” in device manager). 
 1920 x 1200 screen resolution
 2 GB DRAM minimum
 At least 200 MB free disk space
 Windows 7 operating system

 Starter Kit – consists of (1) DMC-11610 cartridge, (1) 30 ml bottle of model 
fluid, (1) fill tip, (1) cleaning pad, (1) drop watcher pad, (1) filter and (1) 
syringe 

 Syringes

 Filters

 Fill tips

 Drop watcher pads

 Cleaning pads

 Substrate location and positioning system (fiducial camera system) – Optional

2.0 System Requirements

 Power: 100-120 / 200-240 VAC 50/60Hz 375W maximum

 Environment: It is recommended that the DMP be used in a reasonably 
controlled temperature and humidity environment to aid in uniform test results. 
Atmospheric conditions can affect the materials used in jetting trials.

 Operating:

– Temperature range 15 to 40C
– Humidity range 5-95% RH, non-condensing
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Chapter 1 - Introduction 3
3.0 System Identification

The following diagram shows the major components of the Dimatix Materials Printer.

Figure 1 - 1 DMP 2800 

LidLid Closed Sensor

Print 
Carriage

Maintenance Station Blotting Pad Power Switch Indicator Light

Platen

Drop 
Watcher
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4 Chapter 1 - Introduction
The following diagram shows the major components of the DMP Printer Carriage.

Figure 1 - 2 Print Carriage 

Fiducial Camera

Cartridge Cable

Skew Plate

Holder Latch

Cartridge Holder

Print Carriage
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Cartridge Cable

Skew Plate

Holder Latch

Cartridge Holder
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Chapter 2

Set-Up and Installation

1.0 Unpacking

1.1 DMP

The DMP is shipped in a wooden crate and weighs approximately 45 kg (100 lbs). At a 
minimum two people are required to lift it out of the crate and place it onto a surface 
sturdy enough to support it without excessive vibrations or oscillations. Be careful not to 
put fingers into fan covers on the DMP bottom when lifting.

1. Remove the following items from the box:
 Starter Kit
 Cartridges
 User Manual
 Cables

Figure 2 - 1 DMP items in box

2. Verify contents with checklist

3. Place DMP on an appropriate surface.
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6 Chapter 2 - Set-Up and Installation
 Note: Consider the air flow pattern for proper ventilation.

Figure 2 - 2 DMP air flow

4. Remove shrink wrap from DMP

5. Free items that have been secured for shipping

Figure 2 - 3 DMP Packing material locations

a. Remove packing material from under carriage assembly
b. Remove packing material from front and side of platen
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Chapter 2 - Set-Up and Installation 7
1.2 PC

The PC system is shipped in its original boxes.

1. Remove them from their boxes and set them next to the DMP

Figure 2 - 4 PC placed next to DMP

2. Check back of the DMP for USB, S-video, and power connections. Identify 
appropriate cables.
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8 Chapter 2 - Set-Up and Installation
3. Connect all cables
a. Power cables to DMP, PC and monitor.
b. USB cable from PC to DMP.

c. S-video cable from DMP to PC.
d. Monitor video cable to PC.

e. Keyboard and mouse cables.

Figure 2 - 5 DMP and PC cabling

!
CAUTION Do not connect DMP to PC through a USB hub.

Do not use USB cables longer than 2 meters.

!
CAUTION Do not use video cables longer than 2 meters.
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Chapter 2 - Set-Up and Installation 9
2.0 PC Start up

1. Turn on power to PC

2. Allow PC to go through complete start up

3.0 Starting Your DMP

1. Make sure DMP lid is closed and all shipping foam is removed

2. Turn on power to DMP
a. The light next to the power switch should go on.

Figure 2 - 6 DMP Indicator light

b. Wait at least 5 seconds

4.0 Dimatix Drop Manager

1. The DMP 2800 icon is on the PC desktop. 

2. Select the DMP 2800 icon on the screen.

Figure 2 - 7 Drop Manager icon on PC screen

!
CAUTION Do not change the country settings or the regional 

settings in the Windows 7 Operating System. The 
software will not operate properly. 

Dimatix Drop Manager
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10 Chapter 2 - Set-Up and Installation
3. Double click to initiate the Dimatix Drop Manager application.

4. After initiating the program, click OK to allow the DMP to run through its 
initialization sequence.

Figure 2 - 8 Unobstructed platen dialogue
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Chapter 3

Initial Start-Up Operation

1.0 Install Cartridge

The following steps tell you how to install the Dimatix Model Fluid Cartridge.

Figure 3 - 1 Install cartridge - Open Lid

1. Prepare the Dimatix Model Fluid Cartridge from the Starter Kit. See Cartridge 
Filling instructions in Chapter 10.
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12 Chapter 3 - Initial Start-Up Operation
2. Lift the DMP lid until it is fully open.

Figure 3 - 2 Install Cartridge

3. Insert the cartridge into the cartridge holder on the carriage with the electrical 
connection pads towards the back of the machine matching the connector of the 
holder. There is only one way for it to fit. Push it down firmly so that it “clicks” 
into place.

4. Pull the cartridge holder latch forward and down until you hear it click and 
locks into place. Check to see that the cartridge is sitting flat in the holder.
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Chapter 3 - Initial Start-Up Operation 13
Figure 3 - 3 Installing the cartridge

5. After the cartridge is installed, close the lid. You should hear a pump turn on to 
control the meniscus pressure.

6. The following window displays.

Figure 3 - 4 Confirm load cartridge settings window

7. Click Yes to load the settings for Dimatix Model Fluid.

8. After clicking Yes, the screen advances to the Select Pattern Screen.
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14 Chapter 3 - Initial Start-Up Operation
2.0 Select Pattern

The Select Pattern window lets you select a pattern for printing.

Figure 3 - 5 Select Pattern screen

1. The Dimatix test pattern is auto-selected. This is a general use pattern which 
lets you see that the system is operating correctly. 

2. Click on the Next button to proceed.

3. This takes you to the Load/Unload Substrate screen.
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Chapter 3 - Initial Start-Up Operation 15
3.0 Load/Unload Substrate 

The Load/Unload Substrate tab is where you set the platen temperature and vacuum. It is 
also where you must enter the thickness for the intended substrate. 

Figure 3 - 6 Load/Unload Substrate screen

1. To start, use the enclosed piece of glossy ink jet paper to run the test pattern. This 
paper is about 250 micrometers thick. Enter 250 (µm) in the box either by using 
the up or down arrows on the box or placing the cursor in the box and typing in the 
number. The system automatically adjusts the height of the cartridge to about 1.0 
mm above the substrate.

!
WARNING Make sure that you always enter the correct 

thickness. Entering a number that is smaller than 
the actual thickness can make the carriage crash 
into or drag across the substrate causing damage to 
the substrate and/or the machine. 
FUJIFILM Dimatix, Inc. Confidential Information Doc. # PM000040 Rev. 05
 December 8, 2010



16 Chapter 3 - Initial Start-Up Operation
2. Open the lid and place the substrate on the platen. Register it to the marks in the 
back left corner of the platen which is a general substrate registration position. 
This is important to note since it is the approximate location from which the 
patterns to be jetted are referenced initially.

3. After placing the substrate on the platen, turn on the platen vacuum by selecting 
the Vacuum On button. If your substrate is not very flat, stiff, or smaller than 
the platen you may need to cover some of the open vacuum holes with mylar, 
adhesive tape, or other material to direct more vacuum to your substrate.

4. If you want to heat the platen, you can enter the temperature in the box by 
typing or using the arrows. The system does not print until the platen reaches 
the desired temperature. This may take up to 20 minutes for a setting of 60°C. 
To run the platen at ambient temperature, click on the down arrow on the box 
until you get to a line in the box which represents a setting of “no- 
temperature.”

5. Click on the Next button to go to the Print Set-Up tab.
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Chapter 3 - Initial Start-Up Operation 17
4.0 Print Set-Up

The Print Set-Up screen summarizes the previously made selections. This screen displays 
the Print Pattern, the Substrate Settings, and the Cartridge Settings.

Figure 3 - 7 Print Set-Up screen

Now you are finally ready to start jetting. The pattern has been selected, the Substrate 
Settings have been entered, and the Cartridge Settings have been entered.
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18 Chapter 3 - Initial Start-Up Operation
1. Click on the Print button and the Print Preview window opens. This window 
shows where the print origin is on the platen, where the image to be printed is 
and the number of nozzles used to print.

Figure 3 - 8 Print Preview screen

2. Click on the Print button to print the pattern. Your DMP jets the test pattern.

4.1 Nozzle Test Pattern

A 16 line test pattern can be run to see the performance of each nozzle individually. 
This is done from the Print Set-Up screen. 

1. Set the Cartridge to 90 degrees.

2. Hold down the Ctrl key on the keyboard while clicking on the Print button at 
the bottom right of the screen. 

You have successfully completed a print sequence.
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Chapter 4

Screen Descriptions

1.0 Main Screen

The Main Menu screen has three pull-down menus: File, Tools, and Help.

Figure 4 - 1 Main screen
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20 Chapter 4 - Screen Descriptions
1.1 File Menu 

There are two options from the File menu.

 Printer preview enabled – this item allows you to turn the Print Preview 
screen on or off prior to starting a print job.

 Print Info. Logging enabled – this switch enables the printer to write 
information about print jobs and the print parameters to a log file in the Print 
Logs folder. This folder is found in the directory: 

C:\Users\Public\Public Documents\DimatixDropManager\PrintLogs

if you did not change the path during software setup.

1.2 Tools Menu

The following options are available from the Tools drop down menu:

 Cleaning Cycle Editor – for creating a sequence of operations to save as a 
cleaning cycle file.

 Pattern Editor – allows creation or modification of a drop pattern for printing.

 Pattern Editor (Bitmap images) – imports .bmp files into the DMP software.

 Waveform Editor – controls the shape of the pulse to the nozzle.

 Replace Cleaning Pad – initiates the process for the periodic change of the 
cleaning pad.

 Configure UV Lamp – controls UV lamp settings. The following screen is 
displayed when you select this option.

Figure 4 - 2 The Configure UV Lamp screen
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Chapter 4 - Screen Descriptions 21
 Display UV Enable Check box – lets you enable and disable the display of the 
UV option on the DDM main screen.

 Comm Port Number – refers to the communication port that the computer uses 
to talk to the UV lamp.

 UV Start Position – Lets you set an offset value to the position where the lamp 
turns on during a carriage pass. 140 is the standard value and starts the lamp just at 
the left corner of the platen. The maximum value is 180.

 Note: The UV lamp is optional equipment for the DMP2800. Please contact 
FUJIFILM Dimatix customer support at cs@dimatix.com for details.

Some of these options are also available from the Tools menus of other screens. For 
further explanations of these options see the appropriate sections of this manual. Consult 
the Table of Contents or the Index for the appropriate sections.

1.3 Help menu 

 Printer Information – This option provides information regarding the FPGA and 
Firmware version on the DMP and its serial number.

 Note: The information in the following image is for example purposes only and 
may not match the information for your DMP.

Figure 4 - 3 Printer Configuration screen
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22 Chapter 4 - Screen Descriptions
 About – The following screen provides information about the Dimatix Drop 
Manager (DDM) software version. To exit press the OK button in the lower 
left.

Figure 4 - 4 DMP About screen

 Remote Control – Activate this option in order to enable a remote control 
session with FUJIFILM Dimatix customer support.

 Note: You also need to schedule a remote control session with FUJIFILM 
Dimatix customer support via telephone =1 (408) 565-7474 or via email 
cs@dimatix.com for the remote control session to be initiated.

 System Diagnostics – This item opens a window that helps you trouble shoot 
different errors that might occur during operation of the printer, as described in 
the System Diagnostic section later in this manual. 

An additional program feature is a link to the FUJIFILM Dimatix Web site. If your PC 
is connected to the internet, click on the Dimatix logo on the bottom right of the various 
DDM screens to automatically connect to the web site.
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Chapter 4 - Screen Descriptions 23
2.0 Cartridge Settings

In the start up procedure we showed you how to select a file with a preset cartridge setting 
that had been predetermined for the test fluid by FUJIFILM Dimatix. Now we will get into 
the details of the settings and the editor screens.

Click on the Edit button in the Cartridge Settings box to display the following screen.

Figure 4 - 5  Cartridge Settings screen

In the above window you can load a previously created cartridge setting file from the File 
menu. You can also save your cartridge setting files. 

2.1 Waveform Tab

From the Waveform tab the voltage of each nozzle can be individually adjusted by typing 
a number in the individual nozzle box or by clicking on the up or down arrow in the nozzle 
box. You may want to do this to adjust drop velocities of individual nozzles, since velocity 
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24 Chapter 4 - Screen Descriptions
is a function of voltage (see Figure 8-5). You can also change all of them 
simultaneously with the Adjust All arrows. (See Waveform Editor for effects of voltage 
on jetting). The Increment number is the amount the voltage will change with one 
click on the up or down arrow buttons. The Waveform tab displays the active 
waveform. You can load previously saved waveforms using the Select button or you 
can edit the active waveform using the Edit button.

 Note: Once you have established the settings for a particular fluid, you may 
have to adjust the voltages for a new cartridge to match the drop 
velocity of a previous cartridge. See Drop Watcher for instructions on 
setting drop velocity.

 Note: Tickle Control can only be accessed by opening the cartridge settings of 
the Print Set-Up screen in the DDM main window. Opening the 
cartridge setting via the Drop Watcher does not allow you to change 
tickle control as it is displayed in gray.

The Tickle Control enables and controls the low amplitude pulse that is given to the 
nozzle periodically simply to move the meniscus slightly but not eject a drop. For 
certain jetting materials this prevents the nozzle from “skinning over” due to fluid 
evaporation. The “tickle” function is completely adjustable and, is very important for 
some fluids and not required for others. Test this function with your fluid before setting 
it as a default.

The low amplitude pulse that tickle control sends to the nozzle can be modified in the 
Waveform Editor window as the non-jetting waveform. The frequency set in tickle 
control is always active when the printer is not printing. This includes the times during 
which the carriage is above the maintenance pad, on its way to the selected print area, 
or on its way back from one print pass to start the next pass. However, during printing, 
the tickle frequency is the same as the jetting frequency set with the waveform editor. 
So during one print job, the printer repeatedly switches between the two pulses.
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2.2 Cartridge Tab

If you click on the Cartridge tab in the Cartridge Settings window, the following screen 
displays.

Figure 4 - 6 Cartridge Settings – Cartridge Tab

This screen lets you set the Cartridge Temperature. This is usually used when the fluid 
is too viscous to jet and you need to lower the viscosity by raising the temperature to get 
the desired jetting performance.

Also on this window is the setting for Meniscus Vacuum. Ink jetting devices operate 
under negative pressure to keep the meniscus at the edge of the nozzle. You may need to 
adjust this depending on the viscosity and surface tension of your fluid. Four inches of 
water is a typical value. Having the correct meniscus vacuum level usually affects the high 
frequency performance of the fluid you are jetting.

The Jets to Use function allows you to select the range of nozzles you wish to use to jet 
your pattern, if you want to use fewer than all sixteen. The software automatically 
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26 Chapter 4 - Screen Descriptions
compensates for the number of nozzles used but the nozzles selected can only be one 
series of adjacent nozzles.

The Cartridge Print Height sets the distance of the printhead above the substrate. It 
can be adjusted from .250 mm to 1.50 mm. 

 Note: Take care to set the Substrate Thickness and Cartridge Print Height 
accurately to avoid hitting the substrate during printer operation.

2.3 Cleaning Cycles Tab

The Cleaning Cycles tab lets you control how the print cartridge is cleaned before, 
during, and after printing. Some fluids do not need periodic maintenance, while others 
need a high amount of maintenance to keep nozzles clear and functioning properly. 

Figure 4 - 7 Cartridge Settings – Cleaning Cycles tab
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Chapter 4 - Screen Descriptions 27
 Select button – lets you select an existing cycle in the cleaning cycle folder.

 Edit button – lets you edit that cycle with the editor window.

 Start of Printing – refers to the cleaning you want to do at the beginning of the 
print. Select a cycle you wish to run to enter one in that box or you can edit an 
existing file with the Edit button. 

 During Printing – refers to the cleaning cycle you want to run while printing your 
pattern. This can be set to run every so many number of Bands (one cycle of the 
carriage across the platen and back is a band) or every so many Seconds of 
printing time. Select a cycle you wish to run by clicking on Select and choose one 
from the folder or you can edit an existing one with the Edit button. Whichever is 
more frequent between Run every x Bands OR Seconds (depending on printing 
speed) is the cycle that is used During Printing.

 End of Printing – refers to the cleaning you would like to do at the end of your 
printing. Select a cycle you wish to run to enter one in that box or you can edit with 
the Edit button.

 While Idle – refers to any cleaning you would like to do while the system is not 
printing but is on and you have a cartridge installed. Select a cycle you wish to run 
to enter one in that box or you can edit with the Edit button.

 None – is a preexisting empty cleaning cycle that you can use in order for the 
printer to not do any cleaning during that time.

 0 – can be entered where numbers are required to indicate not to run that cycle.

3.0 Cleaning Cycle Editor

The Cleaning Cycle Editor is run 

 by clicking the Edit button next to any of the cleaning cycles or

 by selecting Cleaning Cycle Editor from the Tools menu in the Cartridge 
Settings window or the DDM Main screen or

 by selecting the Cleaning group in the Drop Watcher window. 
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From this editor you can create sequences of operations that can be saved as a cleaning 
cycle file. Refer to the Cartridge Maintenance section in the back of the manual for 
more details. The default cleaning cycle, Spit Purge Spit, is shown below.

Figure 4 - 8 Cleaning Cycle Editor screen

 Spit – refers to jetting the nozzles for the designated time at the given 
frequency.

 Purge – refers to pushing fluid out through the jetting device with pressure 
(system is preset to 5psi). This process is usually used to get air out of the 
jetting device.

 Blot – refers to the cartridge simply coming down and making contact with the 
cleaning pad for the designated time. As the nozzle plate is recessed into the 
cartridge it does not touch the cleaning pad. The cleaning pad gets close enough 
to absorb fluid residue on the nozzle plate.

 Note: It is important to make sure that the cleaning pad is not saturated or 
clogged to ensure good removal of the fluid from the nozzles after 
purging or spitting.

 Delay time – is the time after the cleaning before going to the next step in the 
cycle.

A cleaning cycle can be very simple, such as a “2 second blot” or they can consist of 
several combinations of actions (spitting, purging, and blotting) with varying times. 

Here is how to create a cleaning cycle:

1. Click on the Spit, Purge, or Blot.
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2. Then enter a number or use the arrows for the Time, Frequency or Post Delay 
that you want. 

3. Click the Add button to enter it into the table and incorporate it into the cycle. 

4. If you want another action to occur next, simply repeat the process. 

5. If you want to delete a step, highlight it in the table by clicking on it, then click the 
Delete button.

6. When you have built your cleaning cycle, Save it with a name that describes what 
it does using the Save As from the File menu.

If desired you can run the cleaning cycle you just created by clicking on the Run Now 
button in the DDM main window.
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4.0 Waveform Editor

The waveform editor is where you make changes to the waveform by adding or 
deleting segments, make changes to the segments, or rescale a waveform.

Figure 4 - 9 Waveform Editor screen

This is the control screen for the electrical signal that triggers the drop ejection. This 
signal is shown in the Jetting Waveform section. The signal consists of multiple 
segments (four in the above example). To adjust a segment, simply point your with 
your mouse and click on it. The selected segment changes from blue to red. 

The Waveform Basics chapter, later in this manual, describes how changing the 
waveform affects drop ejection. There is an application note available through the Tech 
Support link at the bottom of the FUJIFILM Dimatix home page that elaborates on this 
topic.
Doc. # PM000040 Rev. 05 FUJIFILM Dimatix, Inc. Confidential Information
December 8, 2010



Chapter 4 - Screen Descriptions 31
4.1 Individual Segment Controls

In this group you have several parameters at your control. If you want to modify a 
segment, click on that segment in the graph with the mouse to highlight it. Now modify 
the parameters for it by typing in a number, using the up/down arrows or slider bar.

Level – This is the percent of the amplitude relative to the value specified in 
the Cartridge Settings Waveform screen.

Slew Rate – This is the slope of the line in the waveform during voltage ramps.

Duration – This is the length (in time) of the segment.

You can add waveform segments to optimize drop ejection. Click on the segment that you 
want to place a new segment in front of and click the Add button. You can now modify 
that segment as you would the others. You can delete a segment simply by clicking on it 
and selecting the Delete button.

 Note: The duration and the level of a segment can also be modified by holding 
down the mouse button and moving the mouse. Hold down the left mouse 
button and move the mouse up or down to modify the level of a segment. 
Hold down the right mouse button and move the mouse left or right to 
adjust the duration of a segment. These instructions are in the box to the 
right of the graph.

4.2 Overall Waveform Controls

Duration Scaler – This feature allows the user to easily scale the entire 
waveform pulse width at once. This is useful when you are using fluids with 
different densities. Fluids with higher densities generally need longer pulses. 
Enter a number in the box then click the Rescale Waveform button. The entire 
waveform’s width changes by multiplying its current width by the Rescale 
number. For example, if you enter 1.1 in the Duration Scalar box, it adjusts 
each waveform segment’s length proportionally to multiply the waveform’s 
overall width by 1.1, which is a 10% increase. 

Width – This box displays the overall pulse time width for the entire 
waveform.

Maximum Jetting Frequency – The maximum jetting frequency is 
established by the user during initial fluid characterization using the drop 
watcher system. During initial characterization the maximum frequency of 80 
kHz should be entered into the waveform file being loaded. This value dictates 
the scale for the Jetting Frequency Maximum in the Drop Watcher window. 
After the user has established the maximum sustainable jetting frequency in 
the drop watcher it is essential to ensure the maximum jetting frequency 
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setting in the waveform file does not exceed the frequency used to optimize 
jetting in the drop watcher. 

4.3 Non-Jetting Waveform

The Non-Jetting Waveform can be modified just like the jetting waveform. The 
instructions are in the box to the right of the graph.

4.4 Jetting Waveform vs. Non-Jetting Waveform

When the printhead travels over the print area, the software automatically tells it which 
nozzles to jet and which are idle. The idle nozzles get the amplitude signal displayed in 
the Non-Jetting Waveform chart. The jetting nozzles get addressed with the Jetting 
Waveform. 

The Non-Jetting Waveform is also the pulse signal that the Tickle Control sends to 
the printhead during non-printing times. Such as when the carriage is above the 
maintenance pad, or when it is moving to the defined print area or moving between two 
print passes. Raising the amplitude of the non-jetting waveform above the default zero 
condition can help some fluids to start-up more reliably. 

5.0 Replacing Cleaning Pad

Located in the Tools pull down menu on the DDM main screen is a feature called 
Replace Cleaning Pad. You will want to replace the cleaning pad with a new one 
when it gets filled with fluid or clogged by fluid residue and does not effectively blot 
the nozzle surface of the cartridge, or you are changing cartridge fluids and don’t want 
cross contamination from contacting the previous material on the cleaning pad. 

!
CAUTION If you fail to limit this frequency setting to the 

maximum frequency used during drop watcher 
evaluation you can create a situation where the 
system uses one frequency for drop watching and 
another for printing. This invalidates the correlations 
between visual observations in the drop watcher and 
actual printing performance!
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To replace the cleaning pad select Replace Cleaning Pad from the Tools menu. The 
cartridge moves to allow access to the pad.

Figure 4 - 10 DDM – Moving the Cartridge screen

DO NOT open the printer lid until told to do so. 

IMPORTANTIMPORTANT Opening the lid while the printer is in motion 
necessitates a re-initialization of the printer.
FUJIFILM Dimatix, Inc. Confidential Information Doc. # PM000040 Rev. 05
 December 8, 2010



34 Chapter 4 - Screen Descriptions
Figure 4 - 11 DDM – Open the lid screen

Open the lid and replace the pad.
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Figure 4 - 12 DDM – replace cleaning pad screen

Replace the pad by:

1. Taking the top clear cap of a new Cleaning Pad assembly and push it down on the 
old pad until you hear a click and then simply pull it out.
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2. Insert the new pad and holder by pushing the pad and holder down into the spot 
where the old one was until you hear a click.

Figure 4 - 13 Cleaning Pad replacement

When the lid is closed the carriage moves back to the cleaning station.

IMPORTANTIMPORTANT Be careful not to remove the cleaning pad by itself. 
This can damage the springs holding the receptacle 
which will then not position it correctly. Do not 
touch the top of the new maintenance pad with your 
fingers.
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Pattern Printing

If you are printing a pattern on a substrate that you will either remove or reposition, or you 
want to change cartridges in between printing two layers, be sure to set the print origin 
before printing the first pattern. This is done using the Fiducial Camera. If you change 
cartridges, you also have to perform a drop offset adjustment.
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1.0 Select Pattern

The following screen allows you to pick a print pattern file that has already been 
created, or to create a new one.

Figure 5 - 1 Select Pattern screen

From the Select button in the Print Pattern box you saw earlier that there are several 
predefined standard pattern files. 
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1.1 Predefined Standard Patterns

Figure 5 - 2 Predefined test patterns

2.0 Create Your Own Pattern

The Pattern Editor lets you create or modify patterns of drops for printing, and easily 
repeat them over the entire substrate if needed. The basic pattern, at the lowest level, 
(Pattern Array) is a collection of rectangles that are called pattern Drop Position 
Arrays. Each of these rectangles may be small enough to represent a single drop, or thin 
enough to represent a line of drops, or large enough to represent a fully filled-in 
rectangular area.

In all cases, X increases to the right, and Y increases toward the front of the printer. All 
dimension parameters are in millimeters except for the Drop Spacing, which is in 
micrometers. All dimensions entered into the pattern generator are rounded onto the Drop 
Spacing.

Microscope
Slide 25K Array

Line Array 1 mm Hatch 1 cm Solid Dimatix Test 
Pattern
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By selecting the Edit button on the Select Pattern screen the following screen appears:

Figure 5 - 3 Pattern Editor screen

2.1 Substrate

The Dimensions is the total area to print. Generally most people jet on only a single 
substrate. But you could place several smaller substrates on the platen and jet on all of 
them at once. Verify that the total area is not larger than your substrate.

The Leader Bar is a vertical bar that can be jetted to the left of your pattern by 
checking the Enable box. This is a commonly used procedure in ink jet printing to pre-
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jet nozzles to keep them active and their drop velocity uniform to improve pattern quality. 
The Width of it and the Gap of the leader bar can be entered in the boxes.

 Note: Your pattern is automatically shifted to the right when you create a leader 
bar by the amount of gap and width. It is not automatically returned to its 
original position if you later decide to disable the leader bar. 

The Drop Spacing is the center to center distance from one drop to the next in X and Y 
position to create the pattern. Although this value can be adjusted in 1 m increments it is 
always rounded to the next 5 m increment as soon as you start printing this pattern file. 
The X spacing is controlled by the x axis encoder, while the y axis is controlled by the 
cartridge angle.

 Note: For the first print outs of Dimatix Model Fluid on ink jet paper a drop 
spacing of about 20 m usually gives good printing results.

The Layers box feature allows you to reprint the same pattern over itself automatically. 
The Count number is the number of times you want to print the pattern and the Interlayer 
Delay is the delay time between each layer, additional to the amount of time spent doing 
any before print or after print maintenance on the cartridge.

If you click on the Preview Drops button, a window pops up showing the area you have 
designated. The total area of the window represents the platen. If the substrate area you 
entered is smaller than the platen it shows as a beige shape inside the white area. 
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Your Pattern Array area is delineated within the substrate area outlined.

Figure 5 - 4 Pattern Block Array

2.2 Pattern Block Array

In the Pattern Array box enter the point on your substrate where you want the pattern 
to start printing in X and Y, referencing from the print origin. Then enter the X width 
and Y height of the block you want to make. The X and Y sizes entered should be at 
least large enough to enclose the collection of rectangles defined in the Drop Positions 
Array box (see below).

 Note: The default print origin is approximately -1 mm, 7 mm (x,y) from the 
0,0 corner scribed in the back left of the platen. See the Fiducial 
Camera section of this manual for more information.

To print a repetitive array of the pattern block in your print area, enter the X and Y 
Pitch dimensions. The Pitch is the distance from the start of one pattern to the next. 
Enter the number of patterns (X count) to print in the horizontal direction, and the 
number of patterns (Y count) to print in the vertical direction. 
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2.3 Drop Position Array

The pattern generator works with one or more user-entered rectangles of X width and Y 
height. There are two ways of creating a feature in a Pattern Array. You can enter values 
manually in a table or you can use the mouse to create features. 

To manually create features enter the dimensions in the Drop Position Array group as 
follows and click the Add button. It is placed in the table on the bottom of the window.

 Enter the position (X and Y) where you want to place the first drop in your Pattern 
in the Pattern Block field. 

 Then enter the width and height of the feature you want to create. For lines, enter 
the width/height of the line that you want. For example, for a horizontal line you 
would enter how long you want it to be in the x direction (X Width), maybe 10 
mm, and for 200 m tall you would enter 200 micrometers for the Y Height. For 
the same vertical line, it would be 200 m X Width, and 10 mm Y height. To 
define a feature that is a single row of dots or a single dot, use a dimension or 
dimensions smaller than the value defined under Drop Spacing.

 The Increment Value is the value at which you want the dimensions to change 
with each click of the arrow buttons. For example an increment value of 1.000 
changes the dimension 1 mm for every click of the arrow. The increment value 
gives you a convenient way to generate a set of related rectangles.

2.3.1 Draw feature

You can also very easily create a feature in the Pattern Array by hovering the mouse 
cursor over the Preview Drops window. Place the mouse cursor in a Pattern Array, hold 
the Shift key down and point, left click, and drag to create a rectangle. A line containing 
the values of your newly created feature are automatically added to the table in the Drop 
Position Array box. This is a fast way to roughly create your pattern. Later on you can 
edit it out by changing the values manually in the Drop Position Array table.

 Note: Only those rectangles that are added to the table on the bottom of the 
pattern editor window get saved once you are done creating your pattern.

If you click on the Preview Drops button, a window pops up which shows you the pattern. 
When you click on a line of data in the table specifying a feature, that feature shows up in 
red on the Preview Drops screen. You can zoom in on the feature by drawing a rectangle 
with the mouse where you can see the individual spots. When you zoom in it is best to 
have Show All Patterns deselected to reduce data crunching. You can continue zooming 
in until you see the grid background. Then when you hold the Ctrl button on the keyboard 
and point and drag the right mouse button on your feature of interest you can zoom in and 
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it stays centered on the screen. You can also draw new features into the pattern by 
holding down the Shift button and dragging a rectangle with the mouse.

Figure 5 - 5 Preview Drops screen
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Figure 5 - 6 Zoomed In area

You can see grey lines on the screen which represent the pattern created in the pattern 
generator. The dots are actually where the drops are placed as the dimensions are rounded 
to fit on the grid you have defined in the Drop Spacing.

If you highlight a line in the table and click the Add button you duplicate that feature. It is 
jetted right on top of itself unless you change the X and Y Start values, which you can do 
by highlighting that data line in the pattern generator table and then changing the numbers 
in the appropriate boxes.

The Preview Spot Size box lets you enter the diameter of the spot that a single drop 
makes on your substrate. This is helpful to visualize how much separation or overlap of 
drops you have in the pattern features depending on their size and the drop spacing used. 
When reviewing the pattern to see how the features match the grid or how adjoining 
features line up set the Preview Spot Size to 10 m.
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The Enable Spot Size feature allows you to zoom in on the image and view the 
individual spots of your pattern. Putting a check in the box by clicking on it enables it. 
Click on it to disable it to view all of the patterns.

The Show All Patterns feature enables you to see all the patterns on the substrate when 
checked.

The 1x button displays the pattern on the screen very close to its actual size.

The figure below illustrates how the pattern editor works. The print origin shifts if a 
leader bar gets used. If no leader bar is used the print origin is at the very top left of the 
pattern. The figure also shows that the leader gets only printed in those passes of the 
print head where the image has content. The leader bar might therefore have gaps in y 
direction. 

Figure 5 - 7 Pattern Editor at work

2.4 Drop Spacing

The drop spacing is the center to center distance in X and Y of the drops that the DMP 
deposits to create the pattern. Drop spacing is adjustable between 5 and 254 m in one 
micron increments. It toggles with the arrows on the box in five m increments. For 
example, with a 50 m drop spacing, the pattern generator places drops 50 m apart in 
X and 50 m apart in Y to fill in your pattern. So, for a 100 m wide, 10 mm tall 
vertical line, the system places 3 drops in the X direction (one for the first edge, another 
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at 50 m, and another at 100 m for the next edge) by 2,001 drops tall. The drop spacing 
therefore determines your resolution or density in the X direction and determines the angle 
at which the cartridge must be set to get the same resolution or density in the Y direction. 
The drop spacing parameter is most useful for altering the fill density (amount of jetted 
ink per area) of lines and rectangles, or it may be used to create rows of individual drops 
which are spaced closer together than 254 m. 

3.0 Bitmap File Printing

To import .BMP files into the DMP Software, select Tools on the DDM main window. 
Then select Pattern Editor (Bitmap images). This opens the Image to Pattern 
Converter window. Then under File, select Open BMP to open your file. 

To open a Bitmap file, set the Drop Spacing you want to use to print the image and then 
select Open Bitmap from the File menu. Then select the Bitmap file you want. 

The file is processed into a pattern file at the selected drop spacing resolution. 

If you want to change the pattern file resolution after it has been imported, then you must 
repeat the import routine with the new drop spacing setting.

 Note: The Bitmap resolution must match the drop spacing setting. If it does not 
match at the time of import, then the image dimensions will change.
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Figure 5 - 8 File Conversion screen

3.1 Substrate Tab

The Substrate Tab has the following features:

 Substrate Dimensions – this is the calculated minimum size of a substrate that 
is needed to print the pattern

 Leader Bar – this is the same feature as for pattern files. It is a vertical bar that 
you may add to your pattern to enhance print quality. 

 Drop Spacing – this is the same as for pattern files, it is the spacing of the 
drops (center to center) in x and y that are jetted to create the pattern.
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 Layers – this is the same as for pattern files and allows re-printing the same 
pattern over itself several times (Count) with or without a delay (Interlayer 
Delay) between.

The Full, Fit, Zoom, and Pan enable movement and zooming of the image. When an 
image is first loaded it zooms to Fit. This shows the full extents of the bitmap. Clicking 
the Full button zooms in on the image to the point where each pixel in the .BMP file is 
displayed as a pixel on the screen. The form may be resized to provide a larger preview.

If the Zoom button is selected, then clicking and dragging the left mouse button over the 
image creates a zoom window. When the mouse is released the image zooms to the 
selected area. If Pan is selected, clicking the left button and dragging in the image moves 
the viewable image in the window. These controls can be used to view the high resolution 
data and aid in selecting the reference point.
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The Tiled Preview button allows viewing of all the patterns to be printed. 

Figure 5 - 9 Placement/Tiling Tab

3.2 Placement

 X Start, Y Start is the position relative to the print origin that the pattern starts.

 X Width, and Y Height is the calculated size of the pattern. 
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3.3 Tiling

This is used to make multiple print copies of the same pattern. The Pitch is the distance 
from the beginning of one pattern to the next as set in X Pitch and Y Pitch. The number of 
patterns is set by the Count.

Figure 5 - 10 Reference Point Tab

3.4 Reference Point

The X Ref, Y Ref, Locate Ref Point, and Set Ref Point provide an additional way to 
position the image by aligning a point in the image to a specific point on the substrate (a 
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point is selected in the image and a corresponding point is selected in the Fiducial 
Camera window).

 To print using a Reference Point in your image, check the box Use Reference 
Point. 

 To set a reference point, first locate the part of the image you wish to align to by 
either using Zoom or Pan. Click Set Ref Point. Then place the cursor on the 
point in the image and click on it with the left mouse button. Or, if you know 
the dimensions for the Reference Point you can type them in directly into the X 
Ref, Y Ref boxes then click Locate Ref Point. This takes you to that specific 
point in the image. The cross hair cursor that displays the reference point shows 
where the pattern is printed. You can make fine adjustments by clicking the 
arrow up/down buttons next to the X Ref and Y Ref boxes. You must save the 
file once you select the point for the DMP to utilize it.

 To complete the Reference Point usage, go to the Fiducial Camera window 
(see Fiducial Camera section). Click on the Fiducial Camera button on the 
main DDM window to open the fiducial camera.

 In the Tools menu of the Fiducial Camera window click on the Set Reference 
Point button.

 Find the point on your substrate where you want to place your selected image 
Reference Point by moving the camera to the desired position. Place and click 
the cursor on your point. 

 Click the Use Reference Point box on the Fiducial camera window. 

 Do not close the Fiducial Camera window before you print. It must stay open. 
Click the Print button on the main DDM window Print Set-Up tab.

The X Width and Y Height values are filled in when a file is loaded. The size is based 
on the image size and the drop spacing. Bitmap files must be printed at the drop 
spacing (resolution or dpi) they were created for, or the image size changes 
accordingly.  To convert from drop spacing to resolution:

Drop Spacing [dpi] = 25400 / Resolution [m]

A status bar at the bottom shows the current zoom factor, the location of the upper left 
of the preview, and the image size. The current cursor position is also displayed. 
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Figure 5 - 11 Reference point settings

When all of the parameters are correct you must save the file as a pattern file (it has a .ptf 
extension). The pattern file is what can be selected from the main form or the fiducial form 
to print.

 Note: Gerber files or other vector based files can be converted to bitmap files 
using the ACE Translator software that is installed on all of our DMP2800 
controller computers. You can find detailed instructions on how to use this 
software in the techsupport section on www.dimatix.com.
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4.0 Print Preview

The print preview can be disabled or enabled in the DDM main window File menu. If it 
is on, it shows a preview before the printing starts. The title bar of the dialog tells if the 
reference or printing origin is being used. The print origin (or reference point) is 
marked with a cross hair. The leader bar is shown if it is enabled.

The preview is sizable so it can be made full screen for more detail. Remember, the 
platen area is not the substrate. The user has to make sure the substrate is placed 
correctly on the platen and that it fits the image they are going to print. The preview is 
meant to make sure that the origin and tiling are set correctly.

The following are some sample screen shots using the reference point and leader bar on 
a tiled pattern. The reference image used in this example is the lower right one of the 
array and there is a leader bar:

Figure 5 - 12 Print Preview – Reference point
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This example shows a tiled array, using a print origin, without a leader bar.

Figure 5 - 13 Print Preview – Print Origin without leader bar
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A tiled image with a bad reference point.

Figure 5 - 14 Using a bad reference point 

The error message you get if you try to print from an origin that takes the image off the 
printable platen area.

Figure 5 - 15 Image area message
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5.0 Cartridge Mounting Angle

Before you jet your pattern, the system calculates the angle to set the cartridge determined 
by the drop spacing specified in the pattern. This angle adjustment is what lets you modify 
the drop spacing in the Y axis.

The following is a top view of the carriage. There are two sets of scales. The outer scale is 
the cartridge angle scale, and the inner scale is the vernier scale to adjust the head angle to 
0.1 degree increments. Release the latch by pulling it forward freeing the carriage plate to 
rotate.

Figure 5 - 16 Carriage latch

Latch
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The following is a close-up of the cartridge angle alignment scale set to 0 degrees. The 
outer main scale is in one degree increments. There is a notch on the 0 point of the 
inner vernier scale is lined up with the 0 on the outer cartridge angle scale.

Figure 5 - 17 Cartridge Alignment scale

The following picture shows how to set the cartridge angle to 11.4 degrees. The 0 notch 
on the inner vernier scale is a little past the 11 degree mark. The next inner mark on the 
vernier that is lined up with a mark on the outer ring is line 4. This gives 11.4 degrees.

Inner Notch
Doc. # PM000040 Rev. 05 FUJIFILM Dimatix, Inc. Confidential Information
December 8, 2010



Chapter 5 - Pattern Printing 59
Figure 5 - 18 Setting the cartridge angle to 11.4°

First – Align inner 
notch with the 11° 
mark on outer ring.

Third – Align the fourth mark on the inner ring 
with the closest graduation mark on the outer 
ring. In this case, the 15° mark. The head angle 
now equals 11.4°.

Second – Count up four marks from the notch on the inner ring.
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The following table shows the relationship of saber angle, resolution, and drop spacing 
for the resolutions that the printer is capable of printing.

 Note: You may want to copy the above table and place it next to the DMP for 
future reference.

Table  5 - 1 Resolutions Relationships

Resolution Sabre angle Drop spacing  Resolution Sabre angle Drop spacing

[dpi] [°] [m]  [dpi] [°] [m]

5080.00 1.1 5 188.15 32.1 135

2540.00 2.3 10 181.43 33.4 140

1693.33 3.4 15 175.17 34.8 145

1270.00 4.5 20 169.33 36.2 150

1016.00 5.6 25 163.87 37.6 155

846.67 6.8 30 158.75 39.0 160

725.71 7.9 35 153.94 40.5 165

635.00 9.1 40 149.41 42.0 170

564.44 10.2 45 145.14 43.5 175

508.00 11.4 50 141.11 45.1 180

461.82 12.5 55 137.30 46.7 185

423.33 13.7 60 133.68 48.4 190

390.77 14.8 65 130.26 50.1 195

362.86 16.0 70 127.00 51.9 200

338.67 17.2 75 123.90 53.8 205

317.50 18.4 80 120.95 55.8 210

298.82 19.6 85 118.14 57.8 215

282.22 20.8 90 115.45 60.0 220

267.37 22.0 95 112.89 62.4 225

254.00 23.2 100 110.43 64.9 230

241.90 24.4 105 108.09 67.7 235

230.91 25.7 110 105.83 70.9 240

220.87 26.9 115 103.67 74.7 245

211.67 28.2 120 101.60 79.8 250

203.20 29.5 125 100.00 90 254

195.38 30.8 130     
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Drop Watcher

1.0 Drop Watcher

In the bottom left of the main DDM window is the Drop Watcher button. Clicking on it 
moves the carriage to the right side of the platen, positioning the nozzles over the drop 
watcher camera system. This system allows direct viewing of the jetting nozzles, the 
faceplate surrounding the nozzles, and the actual jetting of the fluid. The Cartridge 
Settings window also comes up at this time to allow you to modify the waveform and 
view the changes in jetting characteristics.

 Note: Tickle Control is not active (displayed in gray) when you open the 
Cartridge Settings window via the drop watcher. In order to be able to 
change tickle control, open the cartridge settings window directly by 
clicking the Edit button in the Print Setup Tab in the DDM.
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Figure 6 - 1 Drop Watcher screen

1.1 Jetting Nozzle Box

Once the carriage and cartridge are in position, click on the Jetting Nozzle box – 
number 8 should be in the box. When you click on it, the system brings nozzle number 
8 of the cartridge into the center of the screen. You can then increment up or down to 
different nozzles and the system moves that nozzle into center position in the screen. 
There is also a row of the nozzle numbers across the screen in which you can turn any 
of them on or off.
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Figure 6 - 2 Jetting Nozzles box

By clicking the box associated with each nozzle it ejects drops out of that nozzle or turns it 
off. By right clicking a box, the nozzle moves to center position. The nozzle in center 
position always has a green shade. To minimize spraying off of the absorbent Drop Watch 
Pad, the user interface limits selecting jetting nozzles to the four surrounding the Viewing 
Nozzle. 

1.2 Calibrate Nozzle View

The Calibrate Nozzle View feature automatically controls the stage motion to keep the 
nozzles in line when drop watching regardless of the cartridge angle. To perform this 
operation use the following procedure:
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Start by clicking on the Calibrate Nozzle View button in the lower right of the Drop 
Watcher screen.

Figure 6 - 3 Calibrate Nozzle View button

1. Find nozzle 1 (the right most orifice), put the mouse pointer on the nozzle and 
click-drag it to the cross-hair on the screen. Use the focus buttons as necessary 
to refine the nozzle’s focus.

2. Click the Next button and drag the image to the right until nozzle 16 (the left 
most nozzle) is under the cross-hair. Use the focus buttons again as necessary to 
refine the nozzle’s focus.

3. Click the Next button again and you are done calibrating the nozzle view. Now, 
when you select any nozzle from one to sixteen, the selected nozzle should be 
close to the 0 line opening and in focus.

For the stage to move the selected nozzle into position you must index through the 
nozzles using the Jetting Nozzle box. When you open the drop watcher it tries to 
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center nozzle #8 in the middle of the screen and put nozzle 8 in the Jetting Nozzle box. By 
clicking the cursor in the box it turns the nozzle on and moves it up to the 0 line.

 Note: The Calibrate Nozzle View feature can also be accessed by selecting the 
Calibrate Nozzle View option of the Tool menu.

1.3 Cleaning Box

If you want to do a maintenance cycle to improve jetting, you can do that by clicking on 
the Run Now button on the Cleaning box in the upper left corner of the window.

Figure 6 - 4 Cleaning box

1.4 Motion Control Box

There are two arrow buttons near the bottom left of the screen, which allow you to Focus 
the drop watcher camera on the nozzles and drops by clicking repeatedly until the image is 
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in focus. Holding down these buttons results in the camera moving with increased 
increments.

Figure 6 - 5 Motion Control box

1.5 Drop Watcher Pad

The drop watcher pad is located in the center of the drop watcher mechanism and acts 
as the receptacle for fluid during jetting. It needs to be changed periodically as it 
absorbs fluid. Typically this occurs when you see stray drops being deposited on the 
nozzle surface during drop watching or fluid is covering the side of the pad holder. To 
replace the pad simply pull out the holder and insert a new one.

1.6 Viewing Modes

The drop watcher system provides you with two different viewing modes.

If you select the Movie Mode check box, it lets you watch a stroboscopic movie of 
drops in flight as they are ejected from the nozzle. This is real time continuous jetting 
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of the nozzles. Checking this box also changes the buttons Image Title and Capture 
Image to Movie Title and Capture Movie.

Figure 6 - 6 Movie mode box

• The Drop Viewing Speed slider changes the sweep rate of the delay of the strobe 
while in Movie Mode. This has the effect of making the appearance of drop 
formation go faster or slower.

• The Drop Refresh Rate slider adjusts the time at which the sweep delay starts 
over thereby adjusting how long you see a drop in flight.

• If the Movie Mode check box is not checked, then the drops appear to be frozen in 
flight. This mode can be used for closer inspection and measurement. By adjusting 
the strobe delay you freeze the drop at different positions after it leaves the nozzle. 
Notice that this is still real time continuous jetting.

• You can click on the various nozzles to see how they perform.
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In the Graticule Group different versions of the video window’s leader bar or scale are 
available.

Figure 6 - 7 Graticule Group box
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The Display Options lets you turn on or off the image information.

Figure 6 - 8 Display Options box
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The Capture Control group allows you to store a still image or video of the jetting 
with all the conditions and information on it.

Figure 6 - 9 Capture Control box

• The Image/Movie Title button allows you to put a title at the bottom of the 
screen in the image after Dimatix DMP2800 - Your Title Here. The nozzle 
number that you are viewing, the jetting voltage, the cartridge temperature, the 
waveform file name, and the date and time are automatically stored on the 
image.

• The Configure Movie Capture Quality in the Tools menu allows you to adjust 
the quality (and subsequently the file size) of the movie. 

• A way to get to high quality videos and low file size is to use a video editing 
tool like the standard Windows Movie Maker to compress the video. The 
Drop Watcher software initially creates huge .avi files.
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The following screen appears.

Figure 6 - 10 PCI Video Capture screen
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Jetting Control Box

Figure 6 - 11 Jetting Control box

• The Jetting Control box allows you to adjust the Jetting Frequency while you 
are jetting. You can then observe the effects by clicking and dragging the bar 
with your mouse. The minimum frequency is 0.7 kHz.

• The Strobe Delay lets you set the time after the drop ejects at which the strobe 
LED flashes to capture the drop image. This can be adjusted with the slide bar. 
It has the visual effect of freezing the drop in flight. Clicking on the Delay 100 
µs button automatically sets the delay to 100 µs after drop ejection. When the 
nozzles are set on the 0 m line on the screen with the Graticule on you can 
read drop velocity easily off the screen. For example, with a 100 µsec strobe 
delay you are seeing the drop after it has traveled for 100 µsec. If the drop is at 
the 500 µm line then the drop velocity of these drops is 5 meters per second. 
This feature should be used to match drop velocities. A good drop velocity to 
set is between 7 – 9 m/sec. 
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1.7 Tools Tab

The Tools menu for the Drop Watcher window lets you select different features.

• Calibrate Nozzle View – This feature automatically controls the stage motion to 
keep the nozzles in line when drop watching regardless of the cartridge angle. To 
perform this operation follow the following procedure:

1. Start by clicking on Calibrate Nozzle View.

2. The screen image should be close to nozzle 1. Find nozzle 1 (the right most 
orifice), put mouse pointer on the nozzle and click-drag it to the cross-hair on 
the screen. Use the focus buttons as necessary to refine the nozzle’s focus.

3. Click the Next button and drag the image to the right until nozzle 16 (the 
leftmost nozzle) is under the cross hair. Use the focus buttons again as 
necessary to refine the nozzle’s focus.

4. Click Next again and you are done calibrating the nozzle view. Now, when you 
select any nozzle from one to sixteen, the selected nozzle should be close to the 
0 line opening, and in focus.

For the stage to move the selected nozzle into position you must index through the nozzles 
using the Viewing Nozzle box. When you open the drop watcher it tries to center nozzle 
#8 in the middle of the screen and put nozzle 8 in the Viewing Nozzle box. By clicking the 
cursor in the box it turns the nozzle on and moves it up to the 0 line.

 Note: The Calibrate Nozzle View feature can also be accessed by clicking the 
Calibrate Nozzle View button in the Drop Watcher main screen.

• View Cartridge settings – this allows you to open the cartridge settings form if 
they were closed.

• Drop Volume Measurement - this is a procedure that lets you measure drop 
volume by using an average drop weight technique.
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The following screen shots show the procedure as it appears on the system when you 
are running it. Once you click Drop Volume Measurement the following dialogue box 
opens up.

Figure 6 - 12 Drop Volume Measurement

The following dialogue box explains to wait until the carriage moves into position and 
stops. 

 Note: Remember that the DMP lid has a safety interlock attached to it. 
Opening the lid during any system motion causes the system to 
reinitialize the motors. For this procedure it is important that you open 
the lid only if the dialogue tells you to.

Figure 6 - 13 Drop Volume Measurement screen
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When the carriage moves over into position it is about 25 mm above the platen surface.

Figure 6 - 14 Drop Measurement screen

To continue you need a container that you have weighed and that fits under the carriage. It 
is best to use one that is shallow so the carriage can be lowered close to the container (this 
prevents the loss of drops due to air motion or other influences around the print head).

Adjust the carriage as close as you can to the bottom of the container. This yields more 
accurate results.

Figure 6 - 15 Drop Volume Measurement screen – Z Height Adjust

You want to weigh as many drops as practical to get the most accurate weight. The 
number of nozzles you have selected to jet in the drop watcher before opening this menu 
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shows up on the form. The frequency you set in the Drop Watcher is the jetting 
frequency for this procedure. The following dialogue box shows that 7 nozzles are 
selected. The default time period is calculated based on the frequency and number of 
jets to get close to 1 million drops for then the conversion to the expected drop weight 
in nanograms gets very easy. Adjust the time to change the number of drops jetted.

Figure 6 - 16 Drop Volume Measurement screen – Jetting Time

Figure 6 - 17 Drop Volume Measurement screen – Jetting to pan
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Figure 6 - 18 Drop Volume Measurement – Wait

Once it finishes jetting you are ready to calculate the drop mass after weighing the pan.

Figure 6 - 19 Drop Volume Measurement – Finish
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Fiducial Camera

On the main DDM window go into the Tools menu and select Fiducial Functions or click 
on the gray Fiducial Camera button in the lower left.

Figure 7 - 1 Fiducial Camera screen
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The above image is a sample screen shot of the main Fiducial Camera window. The 
fiducial camera is used when you want to deposit a pattern on a pre-patterned substrate, 
or if you are jetting a layer with a different cartridge material or to inspect the printed 
features.

The Camera Field of View. This has a width of 1.62 mm and a height of 1.22 mm with 
a resolution of 2.54 m per pixel.

The Fiducial Camera operates in a Dark Field or a Bright Field mode. Therefore 
there are two different light sources the operator can select. The following picture 
illustrates the hardware switch positions on the camera for the different illumination 
modes. 

Figure 7 - 2 Camera switch for different illumination modes

• Position 1: Bright Field mode

• Position 2: both light sources are switched on

• Position 3: Dark Field mode

The Dark Field mode (switch position 3) allows viewing clear fluids on highly 
reflective surfaces. It requires very low light intensity only. Move the Light Intensity 
slider almost all the way to the left. In this mode the light source illuminates the sample 
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in a way that the objective only collects scattered light from the substrate. This results in 
dark backgrounds with bright objects on top of them. The Bright Field mode (switch 
position 1) works after the same principle as a regular microscope. The light shines on the 
object and gets directly reflected back into the objective. It requires a high light intensity, 
so the Light Intensity slider has to be moved all the way to the right.

 Note: The gain pot located on the top of the camera can be adjusted to one 
extreme or the other to improve the range of the Light Intensity slider for 
either bright or dark field mode.

1.0 Features
• Light Intensity – This slider allows you to adjust the light intensity of the camera 

to optimize the contrast of the image.

• Use Reference Point – By checking this box the DMP positions the pattern’s 
reference point to the Image Reference Point. It does this only with the Fiducial 
Camera window open. If you do not use the reference point, the image is printed 
from the print origin.

• The position of the Reference Point you have selected relative to the selected 
Print Origin is displayed in the X and Y position text fields. This is the physical 
point on the substrate that you want to align a .bmp file for printing.

• Move to Reference Point – This button moves the center crosshair to the position 
of the reference point.

• Set Reference Point – This feature lets you select the reference point in the video 
screen. More detailed instructions for this feature can be found in the Alignment 
Procedures chapter.

 Note: A reference point an only be used for imported .bmp images; not for 
Dimatix Patterns generated with the Pattern Generator. See .bmp printing 
for more information.
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• Move Controls Group

• Platen – The Beige Area is the area where the camera can view a feature. The 
Green Area is where you can set a Print Origin point. The Red Crosshair in 
the platen box window displays the position of the current print origin. The 
Red Box in this window shows where you are currently viewing on the platen. 
The Gray Box indicates the position of the coordinates that are in the X-
Position and Y-Position boxes. If there is a Green Box, it shows you the 
position of the Image reference point you have selected.

• X-Position, Y-Position – These boxes operate in either of two ways. You can 
either enter a number into the boxes and then click the Move To Position 
button and the camera moves to that position. Or you can place the cursor in 
the green area of the Platen box and click on a location and then click on the 
Move To Position button and the camera moves to that point and its 
coordinates are displayed in the boxes.

• Go to Print Origin – Clicking on this button moves the camera back to the 
Print Origin.

• Set Print Origin – The feature sets the origin of your pattern. Detailed 
instructions can be found in the Alignment Procedures chapter.

• X-Track Speed – With this slider button you can adjust the movement speed of 
the stage in the x axis when aligning and making measurements. This 
adjustment is done by placing the mouse curser on the slide and dragging it to 
the desired speed.

• Y-Track Speed – With this slider button you can adjust the movement speed of 
the stage in the y-axis when aligning and making measurements. This 
adjustment is done by placing the mouse curser on the slide and dragging it to 
the desired speed.

• Motion Controls – When the Jog button is selected the Y-, Y+, X-, X+ move 
buttons can be held down with the mouse and motion only stops when the 
buttons are released. When the Step button is selected a click on the Y-, Y+, X-, 
X+ buttons causes a motion of the stage in the selected direction by one 
increment. The increment is set in the Carriage Step and Platen Step text 
boxes to the right of the Y-, Y+, X-, X+ motion control buttons.

• Stage Tab – The Stage Tab allows movement of the platen and the carriage buy 
using theY-, Y+, X-, X+ motion control buttons.

• Focus Tab – These two arrows on the Focus Tab allow you to focus the camera 
up or down. The number in the bottom of the Focus box is the height in mm 
from the last set focus origin that the camera is currently focused to. This 
feature allows you to make Z height measurements. The focused Z height is 
about 32 mm above the substrate. When using the fiducial camera you can only 
print on a maximum substrate thickness of a 25 mm.
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• Set Focus Origin – Once you have focused on the relevant height click the Set 
Focus Origin button. The software stores this value and comes back at this height 
the next time you open the Fiducial Camera.

• Set Focus Stop – This text box sets the step increment that the printer moves the 
Z-stage when moving in Step Mode.

• Y-, Y+, X-, X+ – These buttons allow you to move the carriage to any position 
simply by clicking on the button corresponding to the direction you want to go.

• The X, Y, and Z values under the Motion Control group display the position of the 
center crosshair relative to the Print Origin.

• Cursor X-Position, Cursor Y- Position – This box displays the position of the 
cursor relative to the print origin in either the displayed image or in the Platen box.

• Printing Control

• Print New – This button lets you choose a print pattern from your hard drive.

• Print Current – This button starts printing the pattern currently loaded in the 
DDM window.

• Capture Control – This box allows you to capture the displayed image similar to 
the drop watcher image capture feature. 

• Image Title – Click on this to open the box as seen below to type in a name for 
your image.

Figure 7 - 3 Set Video Title screen

• Capture Image – Click on this to save the image in a file of your designation.

• Display Options – This feature lets you toggle on and off the green Center 
Crosshair, choose to Display Time and Date in the video screen, and choose to 
work in either the Measurement Mode or the Data Point History Mode.

• Text Color – This feature lets you toggle dark and light text color for all 
information displayed in the video screen.

• Zoom Box – Lets you activate and configure the zoom box settings.
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• Data Point History – This box allows you to select any points in your pattern 
and save them in a file for future reference or for analysis in an Excel 
spreadsheet. Simply place the cursor on the point you wish to capture and click 
on it. The X and Y position go into the table. If you click on the line of data in 
the table you can then enter a description of that point. By clicking on the Show 
Data Points or Show Description boxes you can turn those on or off.

2.0 Alignment Procedures

For the printer to print accurately to a defined position you have to perform a series of 
alignments before starting your print job. These alignment procedures can either be 
initiated from the Tools menu or the Fiducial Camera main screen.

Print Origin and Reference Point – These two features compensate for the X and Y 
translative error that one makes when placing a substrate by hand on to the platen. The 
are set by using either the Use Reference Point group or by using the Set Print Origin 
feature on the Fiducial Camera main screen. They are exclusive, meaning that you can 
only print relative to the print origin or relative to the reference point. However, you 
can set both at the same time. Depending on how you start your print job the printer 
either prints relative to the print origin or the reference point. 

• Pattern files (PTN files) can be printed only relative to the Print Origin.

• Converted .bmp files (PTF files) can be printed by either coordinate system. If 
you have the Use Reference Point check box activated and you have defined a 
reference point in the PTF file and you start your print job from the Fiducial 
Camera, you print relative to the reference point.

• If you print from the DDM window, you print relative to the Print Origin.

• If you have NOT set a reference point in the image file or the Use Reference 
Point check box in the Fiducial Camera screen is not checked, then you print 
relative to the Print Origin.
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2.1 Setting the Print Origin

When you click on Set Print Origin the following window displays.

Figure 7 - 4 Set Print Origin screens 1 of 2

Figure 7 - 5 Set Print Origin screens 2 of 2

With the fiducial camera open, move the camera to the point you want to be the origin. 
Place the cursor on the image and click on the point you want for the origin. That becomes 
the origin from which other measurements are made and from which the pattern 
originates. When you click on your point, the crosshairs and camera center on that point. 
You cannot set an origin on the lines scribed in the platen.

 Note: The location which allows you the largest printing area is about 7 mm 
down from the X line and about 4 mm to the left of the Y line.

Trying to set the print origin exactly to he inscribed 0,0 corner leads to an error message.
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2.2 Setting the Reference Point

Set the Reference Point is used to set the physical reference point for an Image 
Reference Point you have selected. The image is aligned so that its reference point is 
printed at this location on your substrate.

When you click on the Set Reference Point, the following window displays.

Figure 7 - 6 Set Reference Point screens 1 of 2

Figure 7 - 7 Set Reference Point screens 2 of 2

Setting a reference point is similar to the procedure you used for setting Print Origin.

1. Move to the position on the substrate you want to use. 

2. Place the cursor on that point on the view image and right click.

3. Use the up/down arrow buttons in the reference points X-Position and Y-
Position boxes to adjust the point.

 Note: You must check the Use Reference Point box on the Fiducial Camera 
window and you must leave the camera window open to print the image 
using the reference point.
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Drop Offset – Drop Offset compensates for the error between the point that the fiducial camera 
is looking at and the position that the cartridge is actually printing to. This offset is set in the 
Fiducial Camera Tools menu. Detailed instructions can be found in the Tools Menu in the Fiducial 
Camera Window chapter.

Calibrate Theta – This feature compensates for the angular error the operator introduces 
when placing a substrate into the printer by hand. This offset is set in the Fiducial Camera 
Tools menu. Detailed instructions can be found in the Tools Menu in the Fiducial Camera Window 
chapter.

The following set of actions have to be performed in the exact sequence in order to print to 
a defined location on the substrate.

1. If any of the following conditions have occurred:

1. head angle changed manually by operator

2. cartridge was replaced

3. nozzle count has changed

4. start nozzle was changed

then the head angle as to be recalibrated and the drop offset procedure has to be 
executed.

2. If the substrate was moved by the operator, then first execute the Calibrate Theta 
function. Then run either the Print Origin or the Reference Point function

2.3 Tools Menu in the Fiducial Camera Window 

• Set Drop Offset – This feature is used to calibrate the position of a new or 
different cartridge to the previous printed pattern. 

 Note: This procedure is very important and always has to be done when a 
cartridge has been changed or the saber angle was adjusted and you want to 
print exactly to a defined spot on your substrate.

• In an area outside your printing area of concern, a pattern is jetted where you can 
locate one single drop. The pattern is printed with the nozzles you have selected, 
the cartridge settings you are using, and the resolution of your last used print 
pattern. It consists of a 10 mm line in X direction with a single dot 1 mm to the 
right of it.

When you click on Set Drop Offset in the Tools menu the following window pops up.
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To start you must have the cartridge set to the angle required by your pattern. At the 
first screen click Next.

Figure 7 - 8 Set Drop Offset screen 1 of 7

Figure 7 - 9 Set Drop Offset screen 2 of 7

Move to a position where you can print the test pattern and place the cursor on the 
screen and click in the fiducial camera screen to select the print location.

Figure 7 - 10 Set Drop Offset 3 of 7
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Figure 7 - 11 Set Drop Offset 4 of 7

Figure 7 - 12 Set Drop Offset 5 of 7

After the test pattern has been printed locate first the line then the single spot and click on 
its center.

 Note: The fiducial camera usually comes to a point somewhere below the line so 
you only have to move in negative y direction to find the line.
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Figure 7 - 13 Set Drop Offset 6 of 7

Figure 7 - 14 Set Drop Offset 7 of 7

It should look similar to the following image.
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Figure 7 - 15 Fiducial Camera screen
FUJIFILM Dimatix, Inc. Confidential Information Doc. # PM000040 Rev. 05
 December 8, 2010



92 Chapter 7 - Fiducial Camera
This routine is now completed. Click the Finish button.

Figure 7 - 16 Set Drop Offset – Procedure Finish screen

If the drop offset is determined to be outside the normal range, it needs to be repeated 
after verifying that the first nozzle selected in the cartridge settings is jetting properly 
and that the cartridge is positioned well in the holder.

Figure 7 - 17 Drop Offset – Outside of Allowable range

This has now adjusted any positional offset from the newly installed cartridge to 
fiducial camera which you set the origins and reference points with.

• Set Drop Offset (Manual) – This is used to calibrate a new or different 
cartridge by creating your own pattern. This may be useful when jetting clear or 
difficult to see fluids. 

• In an area outside your printing area of concern, jet a pattern where you can 
locate one drop. This can be a single drop pattern (which may be difficult to 
find or see) or maybe a square of 5 drops (X and Y) or a + pattern that you can 
find with the camera.
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• When you click on Set Drop Offset in the Tools menu the following window 
pops up.

Figure 7 - 18 Set Fiducial Offset

• Enter the position of the dot you specified as the upper left dot in your pattern file.

• Click on the Set Drop Offset button and the following window pops up.

Figure 7 - 19  Fiducial Video Display – select position

• Click OK.

• Then place the cursor on the center of the drop in the pattern that you just jetted 
and click.

• This has now adjusted any positional offset from the cartridge to what the pattern 
file specifies.

• Calibrate Theta – This feature allows you to compensate for an angular offset that 
you might have on the substrate or pattern that you have placed on the platen. 
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To calibrate:

• Click on the feature in the Tools menu and the following window pops up.

Figure 7 - 20 Theta Calibration – Reference Start Point

• Click on the first point you want to use on the fiducial camera image. The 
following screen then pops up:

Figure 7 - 21 Theta Calibration – Find Endpoint

• Move to the next spot you want to use for Theta calibration by using the X+, 
X-, Y+, or Y- buttons on the Fiducial Camera window. If you are using a 
point far from your current position you may also jump there by pointing to it 
in the green area of the Platen in the Move Controls box on the Fiducial 
Camera window and clicking the Move button. You may also enter the 
coordinates in the Move Controls box and click move.

• After clicking on the second point the following window pops up. Click OK.

Figure 7 - 22 Theta Calibration – Set points
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• Calibrate Thermal Scaling – This feature allows you to compensate for a 
substrate that has changed dimensions during a thermal process after printing, and 
you want to print on it again, or that changes dimensions significantly if heated 
while on the platen.

Figure 7 - 23 Calibrate Thermal Scaling
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• Start by entering the distance between your two fiducial marks on the substrate 
that you are going to use for the calibration.

• Locate your first fiducial mark with the fiducial camera.

• Click on the Start X Measurement (or Y if you have only Y direction marks). 

• Click on your fiducial mark. The button turns green and says Cancel if you 
want to cancel and start over.

Figure 7 - 24 Calculate Thermal Scaling – Cancel X Measurement

• With the Automove box checked the fiducial camera automatically moves in 
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the direction you are calibrating the distance entered in the box. 

Figure 7 - 25 Calculate Thermal Scaling – Locate second marker

• When the camera stops at the indicated position, place the cursor on the second 
mark and left click the mouse. If you don’t see the feature in the image area move 
the camera with the x & y motion controls to locate it.

• Now you want to repeat the procedure for the other axis (Y or X) if you have 
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fiducial marks for that axis. 

Figure 7 - 26 Calculate Thermal Scaling – enter distances

• When you have completed the calibration click the Save button and you are 
ready to jet your pattern that is corrected to the new size of your substrate.
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Figure 7 - 27 Calculate Thermal Scaling – Scaling factors computed

 Note: The reset button restores the default values of the DMP. A software and 
printer restart does the same.

• Measure Cartridge Angle – Occasionally you may experience gaps in your 
printed image. This may be a result of not setting the cartridge angle precisely 
enough and it may need adjusting. This is the procedure to tell you how much you 
are off and which way to correct it. 

• In the Fiducial Camera window Tool menu select Measure Cartridge Angle. 
Then follow the instructions in the window.
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Figure 7 - 28 Measure Cartridge Angle 1 of 7

Figure 7 - 29 Measure Cartridge Angle 2 of 7

This feature uses the outer most nozzles selected in the Cartridge Settings file. 

Figure 7 - 30 Measure Cartridge Angle 3 of 7
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Figure 7 - 31 Measure Cartridge Angle 4 of 7

Move to a space where you can print the pattern or place a different substrate on the 
platen and place the cursor on the starting point on the screen and click on it. The 
system then prints the test pattern.

Figure 7 - 32 Measure Cartridge Angle 5 of 7
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With the X,Y motion controls, place the cross hairs on the center of the top line, click 
the next box, move to the bottom line, center the cross hairs on it and click the next 
box.

Figure 7 - 33 Measure Cartridge Angle 6 of 7

The following window is an example of the results from measuring the jet angle. It tells 
you the direction and how much to adjust the head to get better printing. 

Figure 7 - 34 Measure Cartridge Angle 7 of 7

Click Finish when you are done.

Configure – The configuration should be as shown in the window below. The Dazzle 
device should be selected if your system was delivered with one. If you have an 
internal video card, select the Hauppauge card.
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Configure Video Camera Input – This option lets you set the video setting for the 
fiducial camera. The configuration should be set to the values as shown in the window 
below.

Figure 7 - 35 Video Controller Screen

2.3.1 Options menu in the Fiducial Camera Window

• Platen Vacuum – Here you can switch on and off the platen vacuum without 
having to go back to the main menu. 

File menu in the Fiducial Camera window

• Print New Pattern – This feature allows you to select a new print pattern while in 
the fiducial mode.

• Print Current Pattern – This feature lets you print the pattern selected on the 
main DDM window while in the fiducial mode.

• Exit – Clicking on this allows you to exit the Fiducial Camera window.
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Chapter 8

Fluid Requirements

Some of the fluid physical characteristics to achieve optimum performance are:

• Viscosity – 10-12 centipoise at jetting temperature

• Surface Tension – 28-42 dynes/cm at jetting temperature

• Low Volatility – Boiling points higher than 100° C are preferred

• Density – Specific gravity greater than 1 is beneficial

• Degassing – Additionally the fluid may need to be degassed to remove any 
dissolved gas which inhibits jetting. Typical degassing can be done with a vacuum 
(a negative pressure of 2 psi for 1-2 hours maybe sufficient or up to only 50mbar), 
by using ultrasonic, or by spinning (fully miscible solutions only). 

• Filtration – If particle size allows, it is recommended to filter all fluids to 0.2µm.

• Acidity or Alkalinity – A pH-value between 4 and 9 is recommended.

Refer to FUJIFILM Dimatix Application Notes in the Tech Support link at the bottom of 
the FUJIFILM Dimatix home page (www.dimatix.com) for more information.

1.0 Dimatix Model Fluid

This fluid is a non-toxic, non-hazardous, non-drying fluid used to test and qualify the 
printheads.

• The surface tension is 28 - 42 dynes/cm at jetting temperature. A polymeric dye 
was selected to color the fluid.

• The jetting temperature for Model Fluid is 35° C, resulting in a typical viscosity of 
11.2 to 11.7 centipoise.
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106 Chapter 8 - Fluid Requirements
2.0 Drop Formation

Figure 8 - 1 Waveform: wc_test.csv Voltage: 31 V

The following screen is a typical single pulse waveform such as one used for the 
Dimatix Model Fluid.

Figure 8 - 2 Single Pulse Waveform 
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The following picture shows a captured frame of a video taken during the testing of 
Dimatix Model Fluid. You can see that after the drop leaves the nozzle it has a ligament. 
The liquid, on this small scale, is mostly influenced by cohesive forces within the fluid. 
Here not all of the ligament collects into the main drop again, creating a satellite, which is 
a small drop of ink following or in close proximity of the main drop. Switching to lower 
voltage leads to smaller ligaments. You could reduce the frequency, change the waveform, 
or a combination of these to get your desired drop formation. These drops were jetted with 
25V.

Figure 8 - 3 Capture frame

Refer to FUJIFILM Dimatix Application Notes in the Tech Support link at the bottom of 
the FUJIFILM Dimatix home page (www.dimatix.com) for more information on drop 
tuning.

3.0 Performance 

The following are typical jetting results that the user may get from jettable fluids.
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3.1 Drop Velocity vs. Frequency

Higher viscosity fluids have lower velocity and a better high frequency performance 
due to their dampening effect.

Figure 8 - 4 Drop Velocity vs. Jetting Frequency

3.2 Drop Velocity vs. Voltage with different Viscosities

To maintain a given drop velocity, higher jetting voltages are required for higher 
viscose fluids.

Figure 8 - 5 Velocity vs. Voltage
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Chapter 8 - Fluid Requirements 109
3.3 Voltage vs. Drop Mass

The following chart shows that jetting at higher voltages leads to faster drops. Jetting at 
higher voltages also leads to bigger drops.

Figure 8 - 6 Drop Mass vs. Voltage
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Chapter 9

Waveform Basics

The DMP Drop Manager software has a standard waveform that has been found to work 
very well with the Dimatix Model Fluid. This can be used as a starting point to understand 
the jetting process.

The typical basic waveform is divided into four segments. Each segment has three 
properties: duration, level and slew rate. The 0 segment is connected to the last segment of 
the waveform and is not another segment. Naming it differently has been only done to 
make the systematic of the waveform more transparent.

Figure 9 - 1 Basic Waveform 

The level values, which resemble a percentage of the voltage in segment one and two have 
the most impact on the jetting process. Changing duration of segment one and slew rate 
and/or duration of segment two has a strong influence on drop formation. The applied 
voltage relates directly to the volume of the pumping chamber. Faster changes in voltage 
change the volume faster, bigger changes in voltage cause bigger volume changes.

The slew rate determines how fast the volume changes. 
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1.0 Waveform Editor Window Explanation

Figure 9 - 2 Waveform Editor

As a starting point, adjust the voltage to get some sort of drop starting to eject. Then 
adjust the pulse length to get maximum drop velocity. Once the peak velocity is 
obtained, your fluid is matched to the acoustics of the pumping chamber. Now you can 
start adjusting the segments to optimize the drop formation.

Controls for making adjustments… Select the 
segment then use the controls. Watch the drops 
change velocity and shape on the screen. All 
adjustments are real time.

Overall pulse length. It is related to the speed of 
sound in your fluid. As a rule lower viscosity = 
shorter pulse… higher viscosity longer pulse. Use 
the duration scaler to go up and down (1.1 – 0.9)

Limit the maximum jetting 
frequency for a particular 
fluid here.

The negative section that 
draws fluid into the 
pumping chamber. 
Followed by a hold / 
settling time

The firing pulse. The 
steepness of the slope 
provides the energy for 
the initial ejection. It is 
followed by a hold 
period.

The dampening segment and is 
designed to prevent the printed 
head from sucking air back in. 
This changes with different 
materials. This section brings 
the PZT back to a null position
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The following figure shows the start or standby position of the pumping chamber of the 
piezo-electric printhead as it is before the jetting pulse begins. Notice that the fluid 
chamber is depressed by a bias voltage.

Figure 9 - 3 Waveform – Start

At the beginning of the jetting pulse the decrease in voltage to zero volts brings the piezo 
back to a neutral straight or relaxed position with the chamber at its maximum volume. In 
this phase the fluid is pulled into the chamber through the inlet. It also pulls on the 
meniscus at the nozzle as shown in the following diagram.

Figure 9 - 4 Waveform – Phase 1
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The next phase of the pulse is the drop ejection phase. The chamber is compressed and 
pressure generated to eject a drop.

Figure 9 - 5 Waveform – Phase 2

Next is the recovery phase where the piezo voltage is brought back down to its bias 
level. The chamber decompresses at first only partially and then in full refilling for the 
next pulse. There is also a pull back on the ejected drop at the nozzle at this point.

Figure 9 - 6 Waveform – Phases 4 and 5

In the example below the goal was to get a higher jetting velocity without sacrificing 
too much drop formation quality. In these tests only one parameter was changed at a 
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time. The observed results are listed below. To perform these tests a model ink was used at 
these jetting parameters.

Changed Value Velocity Side Effects

Segment 1:  slew rate
 duration 




possible tails
possible tails

Segment 2:  slew rate  possible tails

Segment 3:  slew rate  -

Segment 4: slew rate  -
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Chapter 10

Cartridge

The following diagram shows the major parts of the Cartridge.

Figure 10 - 1 Cartridge Components

IMPORTANTIMPORTANT When opening the sealed bag that the Fluid Module 
and Jetting Module come in take care to prevent 
particles from getting in the Fill Port.

Fluid Module

Fluid Case

Fluid Bag

Pressure Port
Fill Port

Jetting Module

NozzlesElectrical Connector
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1.0 Fluid Module Filling

The following steps show how to fill the fluid module.

1.1 Fill Syringe 

1. Pull fluid into syringe (1.5 ml.

Figure 10 - 2 Fluid aspiration

2. Install filter onto syringe. If the fluid is known to be filtered properly and not 
have agglomerates, you may not need to use a filter. Dimatix Model Fluid does 
not need a filter.

Figure 10 - 3 Filter installation

!
CAUTION Do not remove the white film around the nozzles. It 

can damage the cartridge.

Do not fill the Pressure Port with fluid. It damages 
the printer.

Do not get fluid on the Electrical Connector. It may 
cause electrical shorting.

Always wear the appropriate safety equipment, such 
as a lab coat, gloves, and safety goggles, when 
filling a cartridge. Use a ventilated hood if the fluids 
you are using necessitate such.
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3. Slip a fill needle on the filter of syringe.

Figure 10 - 4 Tip installation

4. Unscrew and remove the fluid module fill port cap

5. Carefully insert the needle into center fill port trying not to scrape the sides

6. Slowly push the syringe plunger to fill the fluid module. 

Figure 10 - 5 Fluid injection

7. Remove syringe.

Figure 10 - 6 Syringe extraction

 Note: Syringes are typically manufactured with a lubricant (often silicon oil) on 
the plunger. If your fluid is aggressive or cannot be associated with a small 
amount of this fluid, then syringes such as glass may be required.
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2.0 Assembly

The following steps show how to attach the cartridge.

2.1 Attach Fluid Module to Jetting Module

1. Align the pressure port of the fluid module with the opening in the jetting 
module.

2. Push the two halves straight together until the SECOND snap is felt and heard. 
This is a fairly rigid connection and takes a fair amount of force.

Figure 10 - 7 Cartridge assembly

3. Once the two pieces are snapped together the fluid can flow into the jetting 
device of the cartridge. Let the cartridge set for 30 minutes with the nozzles 
facing down. At this point care must be taken to protect the nozzles of the 
cartridge. If the fluid is very low surface tension it may flow out of the nozzles. 
If it is highly volatile it may start drying at the nozzle leaving residue and 
thereby preventing it from jetting. It is best to immediately place the filled 
cartridge in the DMP.

 Note: While snapping the two modules together not push on or touch the 
nozzle plate.

Do not dispose of this product as unsorted 
municipal waste. Collection of such waste 
separately for special treatment is necessary.

(Entsorgen sie dieses Produkt nicht als 
unsortierten Hausmüll. Eine Fachgerechte 
Entsorgung ist nötig.)
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3.0 Cartridge Maintenance

The DMP contains hardware and software to perform one or more maintenance activities 
which are designed to initialize and maintain optimal jetting performance.

• The cleaning station contains an absorbent pad to draw fluid off of the nozzle plate 
when it is brought close to it. It does not actually touch the nozzle surface but 
rather it contacts the face plate of the cartridge around the nozzle plate. The pad is 
replaceable.

• The cleaning station uses air pressure to pressurize the outside of the fluid bag, 
which forces fluid out through the nozzles. This is mainly used to initially prime 
the cartridge, but also as a method for reviving problem nozzles. The DMP 
includes a pump for this function, which is also used for meniscus control.

Specific functions include:

• Purging process pressurizes the cartridge to push fluid out the nozzles to remove 
trapped air to prime or clear the nozzles.

• Spitting is jetting drops out of the nozzles at a selected frequency and duration. 
Tickle mode sends a non-jetting pulse to the nozzles keeping the ink in motion at 
the nozzle plate to help keep it ready to jet.

• Blotting is when the cartridge lowers to the Cleaning Pad so that the pad can 
adsorb excess fluid from the nozzle plate.

• Meniscus Control is a low level vacuum applied to the ink reservoir to prevent ink 
from flowing out of the cartridge nozzles.
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3.1 Cleaning Function Definitions

Maintenance Function Definition Benefits Comments

Purging Applies air pressure to 
outside of fluid bag to 
force fluid through 
entire fluid path and out 
all nozzles at once.

Required for initial use to 
force air out of fluid path 
(prime). 
Clears severely clogged 
nozzles. 
Can also be used to lower 
printhead temperature by 
purging hot fluid and 
bringing system temperature 
fluid into the path.

Produced high flow rate of 
fluid, so purge time should 
be minimized for 1 ml 
cartridges.
Used as last resort for 
clearing clogged nozzles.

Spitting Ejecting a predetermined 
number of drops at a 
predetermined frequency 
from one or more 
nozzles.

Clears the nozzles, brings 
fresh fluid to the pumping 
chamber and nozzles, keeps 
fluid path surfaces wet.

Consumes ink that cannot 
be used for printing. 
Typically used on a 
periodic basis, e.g. every 
X printing passes or every 
Y seconds, to maintain 
robust jetting 
performance.

Blotting Bringing an absorbent 
and/or wicking medium 
in close proximity to 
nozzle plate (may lightly 
touch) to remove excess 
fluid from the nozzle 
plate. No wiping action.

Fluid puddling around 
nozzles can partially attach to 
ejected drops causing 
misdirected jetting. In 
extreme cases, puddled fluid 
will fill nozzle and prevent 
jetting altogether. In addition, 
excess fluid on the nozzle 
can fall or be flung off onto 
substrate or printer 
components.

Risk of cross 
contamination when 
switching cartridges of 
different fluid if cleaning 
pad is not changed.

Tickle Mode Exercising the pumping 
chamber at low 
amplitude to 
rhythmically pulsate the 
nozzle exit meniscus.

Retards skinning over of 
nozzle exit meniscus. Keeps 
nozzle exit wet.

May be sufficient to keep 
nozzles alive for lower 
volatility fluids as an 
alternative to spitting. 
Used while head is 
capped, or for lo use 
nozzles during printing.
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4.0 Failure Modes, Prevention and Recovery

Failure Mode Symptoms Prevention Recovery

1 Volatile solvents 
evaporate (dry) when 
printhead is not being 
used. Fluid viscosity 
increases, fluid dries 
inside of nozzles, and 
crusts on nozzle plate 
surface.

When printing starts 
again, nozzles do not 
fire, or fire poorly (low 
velocity, misdirected).

Cap printhead when not 
printing. Spit into cap to 
saturate air with solvent 
vapors. Spit occasionally 
and/or use tickle mode 
to keep nozzles alive.

Spit or purge, following 
with wipe or blot. 
Replace cartridge if 
severe.

2 Volatile solvents 
evaporate (fluid dries) in 
nozzles that are not 
being used. Fluid 
viscosity increases, fluid 
dries inside of nozzles, 
and crusts on nozzle 
plate surface.

When printing starts 
again, nozzles do not 
fire, or fire poorly (low 
velocity, misdirected).

Exercise unused nozzles 
using tickle mode, and/
or by spitting 
occasionally.

Spit or purge, following 
with wipe or blot. 
Replace cartridge if 
severe.

3 In newly filled 
cartridges there is air in 
the fluid path.

All nozzles fail to fire. None. Purge the head to force 
air out of fluid path and 
fill pumping chamber 
and nozzles with fluid. 
Follow with blot to 
remove excess fluid 
from nozzle plate.

4 Air becomes ingested in 
the nozzle due to 
excessive drop ejection 
dynamics.

Some or all nozzles do 
not fire.

Adjust drive waveforms 
and/or fluid properties.

Purge the head to force 
air out of fluid path and 
fill pumping chamber 
and nozzles with fluid. 
Follow with blot to 
remove excess fluid 
from nozzle plate.

5 Fluid oozes out of the 
nozzles due to gravity 
and capillary action.

Fluid collects on the face 
plate (see next item 
below).

Increase meniscus 
control vacuum level.

Blot the nozzle plate.

6 Drops and/or puddles of 
fluid collect on the 
nozzle plate and hang 
down.

Excess fluid temporarily 
attaches to drops as they 
are being ejected causing 
misdirection and/or low 
velocity. Nozzles are 
flooded and do not eject 
drops at all. Fluid falls 
onto substrate or printer, 
or is flung off by 
carriage motion.

Adjust drive waveforms 
to create more crisp drop 
ejection. Blot or wipe 
surface periodically 
during printing.Increase 
meniscus control 
vacuum level.

Blot the nozzle plate.

7 Pumping force is not 
enough to overcome 
meniscus control 
vacuum.

Some or all nozzles do 
not fire.

Decrease meniscus 
control vacuum level.

Decrease meniscus 
control vacuum level.
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Chapter 11

Print Quality Troubleshooting

Printhead jetting issues and subsequent print quality issues typically fall into four main 
categories. This section shows the most likely causes, the resulting print artifact and 
corrective action that can be taken to mitigate the effects. 

1.0 Misdirected Nozzles

Misdirected nozzles refers to drops that are traveling off axis from left to right, or more 
difficult to resolve is front to back. The following figure illustrates a jet ejection off axis in 
the drop watcher.

Figure 11 - 1 Jets jetting off axis

The primary causes of misdirected nozzles are contamination at or on the nozzle plate and 
or air inside the nozzle descender. Contamination is typically a static condition, meaning 
that the drop consistently jets to the side in spite of repeated cleaning cycles. This 
indicates that debris is lodged just inside the nozzle and is forcing the drop to eject at an 
angle. 
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When an air bubble is present the ejecting drop or more specifically the ligament 
extension appears to swirl as the drop is being ejected. This is caused by micro-bubbles 
in the ink that are stubbornly residing just inside the nozzle opening and affect the drop 
formation and typically drop velocity. Figure 11-2 shows the result of misdirected 
nozzles on a printout. The print spacing in Figure 11-2 has been increased so as to 
better display individual drops and placement issues. In Figure 11-3 there are multiple 
nozzles ejecting off axis as well as mismatched velocities and poor sustainability.

Figure 11 - 2 Misdirected nozzles

Figure 11 - 3 Multiple nozzles jetting off axis
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1.1 Corrective actions:

• Filtering the fluid before jetting helps to remove any agglomerated particles or 
debris that may block the nozzles. Micro filters in the range of 0.2 - 0.45 
micrometers have been found to be adequate. Ensure as well that the fill tip is 
clean. 

• Check to see that the cleaning pad has not become saturated or dried over, replace 
if there is any doubt. A cleaning pad that has lost its absorbent properties affects 
jetting performance.

• Perform a purge cycle with a known good cleaning pad in place and retest. In the 
event that the nozzle has accumulated dried fluid, moisten a clean room cloth with 
the appropriate solvent and place atop the maintenance pad then run a cleaning 
cycle. This should dissolve the residue.

• In the event that the above actions prove unsuccessful, use the advance features of 
the cartridge settings to map around the offending nozzle. Be sure to save the new 
cartridge settings and then reload them at the top menu to make the changes active.

• Certain fluids respond well to degassing prior to loading the fluid module. 
Degassed fluids can aid sustainability and allow for the printhead to start up faster. 

2.0 Non-Jetting Nozzles

Non-jetting nozzles are nozzles that do not eject a drop under any condition and are 
adjacent to nozzles that are jetting properly. This indicates that the waveform is correct. In 
the following figure you can see that the adjacent nozzles are jetting properly yet nozzle 
#15 is showing no drop ejection. 

Figure 11 - 4 Non-jetting nozzles
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When a situation arises that a nozzle that does not seem to want to jet, there are usually 
only two causes. The first would be air entrapment in the pumping chamber which 
effectively cancels or dampens the jetting pulse. If this is the case usually the meniscus 
continues to flutter slightly yet there is insufficient energy to force a drop to form. The 
second occurrence is when the nozzle has become plugged due to debris in the fluid 
path or the nozzle itself has dried over. When a nozzle has become plugged or dried out 
you are not able to observe the subtle pulsations of the meniscus in the nozzle opening. 
In the following figure you can see the effect of a non-jetting nozzle #7on a print out.

Figure 11 - 5 Non-jetting nozzle #7

2.1 Corrective actions:

• As previously mentioned a fresh cleaning pad is critical to the head 
performance. If there is pulsation of the meniscus visible at the nozzle then the 
problem may be air trapped in the fluid path. It is not uncommon to allow a 
printhead to sit for an hour or two after loading. The result is after sitting the 
micro-bubbles that may initially resist purging or wetting are redissolved into 
solution. A purge cycle of 0.5 – 1.0 seconds may also help to remove the 
trapped air. 

• If there are no visible pulsations of the meniscus then the nozzle is likely 
plugged or fluid has not reached the nozzles. Applying an appropriate solvent to 
the nozzle plate may dissolve dried jetting fluid. If the nozzle has become 
occluded with foreign debris then you need to use the advanced features of the 
Cartridge Settings window to map around that specific nozzle. Remember to 
degas and filter your fluids before loading the fluid module.
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3.0 Non-Matched Velocities

When a new printhead is installed it is absolutely essential that you take the time to adjust 
the drop velocities for all sixteen nozzles. This has a direct impact on image quality and 
overall line fidelity. Within the cartridge settings are voltage adjustments for each 
individual nozzle. Perform a Calibrate Nozzle View from the Tools menu in the Drop 
Watcher window. In the following figure you see that nozzle #1 is indeed running slow. 
When the drop velocities are mismatched the result is vertical lines that have uneven 
edges.

Figure 11 - 6 Nozzle #1 running slow
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As seen in Figure 11-7 nozzle #16 is jetting slower that the rest, note the impact on the 
vertical line.

Figure 11 - 7 Nozzle #16 jetting slowest

3.1 Corrective action:

• Within the Drop Watcher use the 100 µs delay adjust each nozzle individually 
by right clicking on the selection box for each nozzle. Having done an Align 
Nozzle View the nozzle being adjusted align to the zero line and make velocity 
matching very easy. Be sure to save the cartridge settings. Then reload them in 
order for the system to actually use them.

• Pay attention to the drop formation and in particular at what distance the drop 
coalesces into a fully formed drop. Higher drop velocities may slightly improve 
drop placement but the sacrifice would be a less than round drop. Lower 
velocities may yield a round coalesced drop but due to lower velocity may tend 
to wander in placement accuracy. 

• Use the drop watcher as an indicator for setting the printhead fly height based 
on the distance that yields a fully formed drop.

4.0 Cartridge Alignment & Drop Offset

Perhaps the most often missed contributor to print quality is the proper alignment of the 
print cartridge. The DMP software relies on the operator to physically rotate the head to 
a saber angle that matches the grid spacing in the pattern to be printed. Failure to adjust 
this angle accurately results in gaps or excessive overlap as well as vertical lines that 
have a noticeable saw tooth to them. The following figure is an example of a cartridge 
alignment that is off by an angle of -2 degrees with nozzle #16 off speed.
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In order to ensure that the pattern you intend to print is aligned to your substrate a drop 
offset routine needs to be run after the cartridge alignment is completed.

Figure 11 - 8 Alignment off by -2 degrees

In Figure 11-9 you can see the result when the cartridge is off by an angle of +2 degrees.

Figure 11 - 9 Alignment off by +2 degrees
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Figure 11-10 shows a cartridge that has been properly aligned. Note the placement of 
the vertical rows and the absence of overlap or gap at the printing pass boundaries.

Figure 11 - 10 Properly aligned cartridge

4.1 Corrective action:

• In the Fiducial Camera window in the Tools menu click on Check Cartridge 
Angle and follow the on screen prompts. Once the pattern has printed and you 
have performed the required measurement, the software prompts you to make 
an adjustment clockwise or counter clockwise. Repeat this adjustment until the 
reported error is less than .25 degrees.

• To ensure drop placement accuracy it is necessary to run the Set Drop Offset 
from the same pull down menu, follow the on screen prompts. This provides the 
software with an accurate XY 0,0 position to reference from.
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5.0 Things to remember
• A piezo driven printhead relies on incompressible liquids throughout the fluid path 

and does not tolerate air in the system well at all. 

• Sometimes allowing the head to sit undisturbed for an hour is the best way to 
ensure good wetting of the printhead.

• Whenever a print cartridge is replaced the saber angle needs to be checked and a 
drop offset adjustment has to be performed again, in this particular order. The 
nozzle velocities have to be re-adjusted. 

• Using the drop watcher, determine the maximum jetting frequency that your fluid 
runs well at, assign that value in the waveform editor and then save that waveform 
to the Cartridge Settings file. Failure to do so could result in jetting frequencies 
that are beyond the limits of your fluid to sustain and result in misdirections, poor 
sustainability, and unacceptable print quality. 

6.0 System Faults

There are several error messages that may occur during operation of the DMP. In these 
cases you usually get a message to power off the DMP and then power it back on. If the 
problem is not remedied by turning the DMP off (leave off for 5 seconds minimum) and 
then back on, the system has to be returned to FUJIFILM Dimatix for service.

6.1 Faults

• The cartridge drive amplifier has malfunctioned.

This is an error in the Amplifier calibration as it tries to communicate with the jetting 
module. Try replacing the jet cartridge. Additionally ensure that the contacts on the 
head carrier are clean and free of contamination and that the cartridge is seated and 
latched in position properly.

• The platen heater is malfunctioning.

This is a result of the platen heater having a short, an open or a thermocouple is not 
reading.

• A motor has malfunctioned

One of several motors has detected an error. This is related to a signal from the FPGA 
and usually indicates an over current condition. With the printer powered down, check 
for material blocking the platen or carriage movement then restart. If you get this 
message with the Platen Theta Home Sensor you can try to recover from that error 
yourself. Therefore turn off the printer and shut down the software. Now with you 
hand reach under the left front of the platen. You should feel a small stepper motor and 
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a shaft sticking out of it. Push the shaft all the way into the motor until its end if 
flush with the motor. Now turn the printer back on and initialize the system. If the 
error persists you most likely have a broken theta sensor or a damaged sensor flag. 
In both cases you need to contact Dimatix customer support @ (408) 565-7474.

• Driver error

The system has reported an error related to the USB driver. Power the Computer 
and Printer off. Rearrange the USB connectors and restart the computer then the 
printer.

• Encoder index

The printer has failed to recognize the index sensors associated with the X and or Y 
axis. Ensure that there is nothing on the encoder strips such as paper chafe or ink 
deposits and make sure the stages are free to move. Power the system down and 
retest. 

• Home sensor

Home sensors are associated with the X axis, Y axis and Platen rotation. Ensure 
that there is nothing blocking any of the axis movement and cycle the printer 
power. If condition persists call Dimatix Customer Support @ (408) 565-7474.

• Movement error

This is a positional fault. This occurs when the printer is commanded to move to a 
specific position, but is not within the preset tolerance when motion stops.

• The printer's 3 volt power supply has malfunctioned.

This is a failure of the logic level power. Turn the DMP off and wait 5 seconds then 
turn back on. If condition persists call Dimatix Customer Support. (408) 565-7474.

• The printer's 5 volt power supply has malfunctioned.

This is a failure of the logic level power. Turn the DMP off and wait 5 seconds then 
turn back on. If condition persists call Dimatix Customer Support @ (408) 565-
7474.

• The purge pressure is too low.

The pressure side of the air system has detected a leak or the pump pressure is 
insufficient. Replace the cartridge with a known good cartridge and retry. Ensure 
that the cartridge is fully seated in the head latch assembly. Refer to System 
Diagnostics in the following section or the Help menu on the main DMP window.

• The cartridge meniscus vacuum can't be controlled.

The vacuum side of the system has detected a leak or the vacuum generator is 
malfunctioning. Replace the cartridge with a known good module and retry. Ensure 
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that the module is fully seated in the head latch assembly. Refer to System Diagnostics 
in the following section or the Help menu on the main DMP window.

• The printer's internal memory has failed.

The Main board memory is at fault. Shut down the Drop Manager Software and the 
DMP. Restart after 5 seconds. If the condition persists, call Dimatix Customer Support 
@ (408) 565-7474.

• The printer CPU firmware upgrade has failed. 

In this case the system asks you to Try Again. Possibly a timing issue between the 
Main board, USB and Computer.

• The printer FPGA upgrade has failed. 

In this case the system asks you to Try Again. Usually a check sum error has occurred. 
Similar to a CPU firmware upgrade failure.

• An undefined printer error has occurred. 

This is typically a motion related error that occurs due to the lid being opened while 
the printer is initializing or performing some type of mechanical motion. Turn the 
system off and restart after 5 seconds.

7.0 System Diagnostics

If there is a fault with the pneumatic system or the Theta Axis the following screens can 
be found in the Help menu in the Drop Watcher main window. You can identify and 
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troubleshoot the system to some extend on your own. Simply place the mouse cursor 
on the Test Control block that you wish to test and follow the instructions.

Figure 11 - 11 Platen Pump screen

Figure 11 - 12 Set Meniscus screen
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Figure 11 - 13 Purge Pressure screen

If there is an error with the Theta motor or platen the following screen can help identify 
and resolve the problem.

Figure 11 - 14 Theta Motor screen
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Figure 11 - 15 Sensor Status screen

If there is an error referring to sensor issues, use this screen to troubleshoot sensor 
status problems.

• Sensor Status – this group shows you the current status of your printer. A green 
colored box means that the sensor has been tripped.

• Disable All Motors – This button disables all motors in the DMP2800 printer. 
You can now open the lid and move the carriage, stage, and Z-Axis by hand. If 
you move them into a sensor, you can observe sensor behavior.

 Note: This is a troubleshooting tool. You should not do this unless you are 
having problems with your printer.
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Figure 11 - 16 General Status screen

• General – You can read out all of the current values of the controlled parameters 
of the printer in this section of the System Diagnostics screen.

• Motion Controls – The motion controls can only be used when the lid is closed. 
They can be used to make the stage of the printer go to a specific position and stay 
there in order to troubleshoot the printer and the software. You cannot print in 
these positions.

8.0 Preventative Maintenance

When installing cartridges, inspect the connector on the carriage holder. If you see any 
fluid on the connector, wipe it off with a clean lint free cloth or other similar material. 
Additionally, wipe any other fluid or debris from the holder area.

Inspect the pressure seal area on the cartridge holder also. Make sure it is free of debris to 
ensure that proper pressure regulation can occur.

Vacuum the fan filters located on the bottom of the printer.

Grease the Y-axis lead screw with Tri-Gel 1200SCas required.

Inspect the encoder strips for obstructions, clean with soft cloth as required.
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9.0 Reference Information

Please visit the FUJIFILM Dimatix web site and the Tech Support link at the bottom of 
the FUJIFILM Dimatix home page (www.dimatix.com) for the latest application and ink 
jet usage information in the deposition field.

Signing up on the Tech Support extranet is free for DMP customers and provides you 
access to a lot of inkjet printing related information. If you have not setup your Tech 
Support extranet access yet, click on the Tech Support link at the bottom of the 
FUJIFILM Dimatix home page (www.dimatix.com). On the Tech Support Welcome 
page, select Create Account. Complete the information and select Save.
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Remote Control

The Remote Control function allows FUJIFILM Dimatix customer support to assist you to 
troubleshoot your printer and software. This button disables video streaming to the 
fiducial camera and drop watcher camera video screens. Once the video streaming is 
disabled it is possible for your computer to broadcast all screens to remote locations 
without running into bandwidth problems.

Once Remote Control is activated the drop watcher screen, the fiducial camera screen, and 
the DDM screen all show red Remote Control labels. The camera screens only update 
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when you click on the Update Image buttons in the upper right corner of the video 
screens.

Figure 12 - 1 DDM main screen in Remote Control mode
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Figure 12 - 2 Drop watcher screen in Remote Control Mode
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Figure 12 - 3 Fiducial Camera screen in Remote Control mode

 Note: Your computer needs to have internet access for FUJIFILM Dimatix 
customer support to set up a remote control session. Running the session 
is independent from running the remote control option in the Drop 
Manager software. No special ports need to be opened for this to work. 
The regular Internet Explorer works fine.
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Specifications

1.0 System Description
 Flat substrate, xyz stage, “ink jet” deposition system

 User-fillable, piezo-based ink jet print cartridges 

 Built-in drop jetting observation system

 Variable jetting resolution and pattern creation PC-controlled with Graphical User 
Interface (GUI) application software

 Capable of jetting a wide range of fluids

 Heated vacuum platen

 Cartridge cleaning station

 Includes PC, monitor, and software
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1.1 Mechanical System

 Printable area

• Substrate size < 0.5 mm thickness: 210 mm x 315 mm (8.27 in x 12.4 in)
• Substrate size 0.5 - 25 mm thickness: 210 mm x 260 mm (8.27 in x 10.2 in)

 Repeatability: ± 25 µm (± 0.001 in)

 Substrate holder

• Vacuum platen
• Temperature adjustable; ambient to 60 °C

 System footprint: 673 mm x 584 mm x 419 mm (26 in x 23 in x 16 in) 

 Weight approximately 43 kg (95 lbs)

 Power 100-120 / 200-240 VAC 50/60Hz 375W maximum

• Fuse @ 250 V 2A SLO-BLO 5 x 20 mm
• Fuse @ 110 V 4A SLO-BLO 5 x 20 mm

 Operating range 15-40 °C at 5-80% RH non-condensing

 Altitude up to 2000 m

 Safety and EMC compliance

• Safety: NRTL Certified to EN 61010-1, UL 61010-1, CSA 22.2 No. 61010-1
• EMC: EN61326-1 Class A, FCC Part 15 Class A

2.0 Cartridge
 Type:Piezo-driven jetting device with integrated reservoir and heater 

 Usable Ink Capacity:Up to 1.5 ml (user-fillable)

 Materials Compatibility:Many water-based, solvent, acidic or basic fluids

 Number of Nozzles:16 nozzles, 254 µm spacing, single row

3.0 Control PC and Application Software
 Pre-loaded patterned templates 

 Pattern preview

 Editors: Pattern, piezo-driven waveform, cleaning cycle, substrate setting

 Bitmap (1 bit) files accepted

 DXF, GDSII and OASIS file conversion to Bitmap using ACE Translator 3rd 
party software
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4.0 Replaceable Items
 Print cartridge with one-time user-fillable reservoir

 Cleaning station nozzle blotting pad

 Drop watcher fluid absorbing pad

5.0 Options
 Fiducial camera for substrate alignment and measurement
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Returning a DMP to Dimatix

When you have to return your DMP to Dimatix for repair, close adherence to our return 
procedure expedites the return. There are three tasks in processing a return:

1. Contact Dimatix Customer Service for return authorization.

2. Clean the DMP.

3. Pack up the DMP.

1.0 Return Authorization 

A Returned Materials Authorization (RMA) is required prior to the return of your DMP. 
When contacting Dimatix Customer Service for an RMA, please have the following 
information available: 

 Company name, contact name, contact phone, fax and/or e-mail information.

 Product being returned, with the Dimatix part number.

 The number of units being returned and their serial numbers.

 Description of the failure for each serial number. For example, “serial number 
390054 has lost meniscus and vacuum.” The information provided about the 
failure is used to perform failure analysis and to determine appropriate repair steps. 
The more detailed the information provided, the better.

 Description of the fluids used (part number and supplier). An MSDS must be 
provided for any fluid or materials used in the printer when the product is returned 
to Dimatix. Information about the fluids also aids in determining repair steps and 
in failure analysis.

Forward this information to Dimatix Customer Service at:

Fax: #(603)448-3658 or e-mail: cs@dimatix.com.
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A Customer Service Representative researches the return request with Technical 
Support, and either provides the RMA number or requests additional information. The 
RMA number must be recorded on the outside of the shipping container when the 
product is returned to Dimatix. MSDSs for any fluid or materials that were used in the 
printer must be included in the return shipment.

2.0 DMP-2800 Cleaning Procedures 

The DMP to be returned should be thoroughly cleaned. This expedites the failure 
analysis. Autopsy returns are dependent upon the perceived problem. Check with 
Customer Service before readying the return as different rules on cleaning may apply.

1. Remove cartridge from printer.

2. Remove cleaning pad.

3. Remove drop watcher pad.

4. Turn off power.

5. Clean all available surfaces with 70% isopropanol using lint-free cloth. If there 
is any visible precipitated material or apparent film on printer parts, these areas 
must be thoroughly cleaned before returning. Use a more aggressive cleaning 
fluid if required.

6. Let the DMP dry completely before packing.

3.0 Packing up the DMP

It is imperative that you repack the DMP properly to avoid damage in transit. If you 
have retained the original shipping crate and materials, please use them when 
packaging for return. If the materials are not available, especially the wooden crate, 
make sure that the DMP is securely packaged with appropriate materials.

!
CAUTION Follow your company’s personal protection gear 

policies when cleaning the DMP. At a minimum 
safety glasses, particle mask, lab gloves, and a 
protective coat should be worn.
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Online Tech Support

FUJIFILM Dimatix's Materials Deposition Online Tech Support provides all registered 
users with easy access to the following information:

 FAQs

 Order Supplies and Replacement Parts

 Ink Jet 101

 Web-based training

 Application Notes

 Popular Jetting Files

 Product Manuals

 DMP Printer Support

 MSDS

To register for a Tech Support account, click on the Tech Support Sign In link at the 
bottom of the FUJIFILM Dimatix home page (www.dimatix.com). On the Tech Support 
Welcome page, select Create Account. Complete the information and select Save.
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Symbols
Alignment Procedures 84

Cleaning Function Definitions 122

Drop Spacing 46

Faults 133

Placement

50

Placement / Tiling 50

A
About this Manual ii

Cautions ii

Important iii

Notes iii

Warnings ii

Wheelie Bin Symbol iii

Alignment Procedures

Set the Reference Point 86

Alignment Procedures

Set Print Origin 85

Assembly 120

Attach Fluid Module to Jetting Module 120

Automove 96

B
Bitmap File

Substrate Tab 48

Drop Spacing 48

Layers 49

Leader Bar 48

Substrate Dimensions 48

Blot 28

Blotting 121

BMP File Printing 47

Bright Field 80

C
Calibrate Nozzle 63

Calibrate Nozzle View 73

Calibrate Thermal Scaling 95

Calibrate Theta 87, 93

Capture Control 83

Capture Image 67

Capture Movie. 67

Cartridge Alignment 130

Corrective action 132

cartridge angle scale 57

Cartridge Maintenance 121

Cartridge Mounting Angle 57

Cartridge Settings 61

Cartridge Tab 25

Cartridge Print Height 26

Jets to Use 25

Cleaning Cycles tab 26

Cartridge Settings 22

Cartridge Tab 25

Cartridge 117

Cleaning box 65

Cleaning Cycle

create 28
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default 28

Cleaning Cycle Editor 27

Cleaning Cycle Editor screen 28
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Cleaning Cycles Tab 26

Cleaning Pad 35

Replace 35

Cleaning Procedures 150

Configure 102

Configure Capture Quality 70
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D
Dark Field 80

Delay 28

Delay 100 72

Dimatix Drop Manager 9

Dimatix Materials Printer (DMP) 1

Dimatix Model Fluid 105

Display Options 83

DMP 1

air flow 6

icon 9

starting 9

Draw feature 43

Drop Manager 79

Drop Offset 87, 130

Drop Position Array 43

Drop Refresh Rate 67

Drop Spacing 43, 45

Drop Velocity vs. Voltage 108

Drop Viewing Speed 67

Drop Volume Measurement 73

Drop Watch Pad 63

Drop Watcher 61

Calibrate Nozzle View 63

Capture Image/Movie button 70

Cleaning Box 65

Display Options 69

Drop Watcher Pad 66

Graticule Group 68

Jetting Control box 72

Jetting Nozzle Box 62

Motion Control Box 65

Movie Mode 67

Viewing Modes 66

Drop Watcher button 61

drop watcher pad 66

Drop Watcher software 70

Drop Watcher 61

F
Failure Modes, Prevention and Recovery 123

Fiducial Camera 80
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bright field mode
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Dark Field 80
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switch position 80

Features 81
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Data Point History 84

Light Intensity 81

Viewing and Capture Control
Capture Image 83
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Image Title 83

X-Track Speed 82
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Y-Track Speed 82
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Fiducial Camera Window

File menu 103

Exit 103
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Tools Menu 87
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Fiducial Functions 79

Fluid Module Filling 118

fill needle 119

Fill Syringe 118

Install filter onto syringe 118

Fluid Requirements

Degassing 105

Density 105

Filtration 105

Low Volatility 105

Surface Tension 105

Viscosity 105

Fluid Requirements 105

Focus Tab 82

G
Go to Print Origin 82

Graticule 73

I
Image Reference Point 81

Image Title 67

Image to Pattern Converter 47

Image/Movie Title 70

Important (Wichtig) vii

Increment Value 43

Initial Start-Up Operation 11

Install Cartridge 11

Introduction 1

J
Jetting Control Box 72

Jetting Frequency 72

Jetting Nozzle box 62

Jetting Waveform vs. Non-Jetting 
Waveform 32

M
Main menu

Help menu 21

Main screen 19

File menu 20

Tools menu 20

Measure Cartridge Angle 99

Meniscus Control 121

Meniscus Vacuum 25

Misdirected Nozzles 125

Corrective actions 127

Model Fluid 105
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Motion Control box 66

Motion Controls 82

Move to Reference Point 81

Movie Mode 66

Movie Title 67

N
Non-Firing Nozzles

Corrective actions 128

Non-Jetting Nozzles 127

Non-Jetting Wave Form 32

Non-Jetting Waveform 32

Non-Matched Velocities

Corrective action 130

Non-Matched Velocities 129
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Online Technical Support 151
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Pattern Block Array 42
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box 42

Pattern Block Drop Position 43

Pattern Editor 39

Pattern Printing 37

Create Your Own Pattern 39

Select Pattern 38

PC
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Start up 9
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Drop Velocity vs. Frequency 108
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with different Viscosities 108
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Platen 82

Predefined Standard Patterns 39

Preventative Maintenance 139
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Printing Control 83
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Print New 83
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Returning a DMP to Dimatix 149

RMA 149

S
Safety (Sicherheit) iv

Safety Information iv

Screen Descriptions 19

Select Pattern 38

Pre-Defined Standard Patterns 39

Set Drop Offset 87
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Set Focus Origin 83
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Waveform Basics 30
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